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Abstract 

Cerebral palsy is a neuromuscular disorder affecting motor function and development 

caused by a lesion to the brain at or around the time of birth. If not given adequate care and 

treatment prior to adolescence, children may lose the ability to ambulate on their own and require 

a wheelchair for mobility. Treatment for individuals with cerebral palsy targets increasing time 

walking throughout the day to avoid muscular atrophy while minimizing excess energy usage 

often seen in pathologic gait. Posterior walkers are commonly recommended by clinicians to 

increase stability and posture during gait. The purpose of this thesis was to further our 

understanding of the use of posterior walkers in both normal gait and pathologic, cerebral-palsied 

gait. 

This work developed a dynamic model of the entire body which incorporated the 

posterior walker interaction forces during the gait cycle. The model was used to compare 

baseline, unassisted gait to gait with a posterior walker in typically developed (TD) and cerebral 

palsy (CP) child populations. Children with CP benefited from the walker through improved 

torso stability and reduced mechanical work of the whole body, particularly in the lower body 

and torso. Increased upper body moments highlighted the cost of pulling the walker and the 

applied vertical loading for support in the CP group. The TD group and the less-effected subjects 

in the CP group were inhibited by the walker as they walked slower and with shorter strides in 

walker-assisted gait. The current design of posterior walkers requires manual propulsion of the 

walker to take advantage of the benefits associated with its use. The dynamic model provides the 

ability to perform simulations with an automated walker which could decrease the energy 

expense of pulling the walker while still providing necessary stability. The development of an 

automated walker could further aid the user by neutralizing the required forces to pull the walker.  
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Introduction 

Typical human gait involves coordination of the segments of the body to move from one 

location to another while maintaining balance. In typically developed children these motions are 

learned and developed from a young age and result in an energetically efficient motion as they 

reach adolescence. In pathologic gait, such as in cerebral palsy (CP), children develop complex, 

abnormal patterns of gait to maintain neuromuscular control of their bodies. For more involved 

patients with a gross motor function classification system (GMFCS) of level III or more, motor 

function deteriorates with age (Hanna et al., 2009). Children with CP have greater energy 

expenditure during gait (Russell, Bennett, Sheth, & Abel, 2011). Those that are ambulatory may 

not be able to walk for the same length of time as typically developing peers. Due to the effects 

of CP, clinicians monitor children as they grow to develop treatment plans that can include 

orthotics and walkers as assistive devices or interventional surgeries to positively affect the 

biomechanics of gait. Posterior walkers have been adopted by clinicians for their positive effects 

on posture during gait (Mattsson & Andersson, 2008). 

Current clinical practice utilizes gait analysis and lower body assessments to measure the 

effectiveness of interventions in CP. The resultant full body effects of interventions have largely 

been ignored in previous work and the load of pulling a posterior walker along for use in gait has 

not been quantified. This thesis focused on the effects of a posterior walker in pediatric gait in 

both typically developed (TD) and CP populations. This was accomplished by: 

1. Developing a dynamic model for subject gait trials with outputs for full body joint 

kinematics and kinetics. 

2. Calculating mechanical work of individual joints and summing into body segments over 

the gait cycle. 
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This research examined the use of a posterior walker in gait for CP and typically 

developed children and quantifies energy expenditure through total mechanical work. It is 

necessary to include all external forces and energies which influence the subject to obtain 

accurate values for mechanical work of the subject. Previous work has not examined the forces 

involved at the handles of the walker and thus ignored the effect of the walker on the energy cost 

of ambulation during walker-assisted gait. This is a problem because the results do not 

incorporate the effect of the walker on the upper body segments. Previous work by Konop 

(Konop et al., 2009) looked at upper extremity kinetics in children with CP. The study found 

significant correlations between upper body kinetics spatiotemporal patterns in CP gait. The 

interaction between walker and user needs to be quantified when the kinetics of the system are 

considered, otherwise the outcomes ignore the reliance upon and the use of the assistive device. 

By incorporating the kinetics of the walker, patterns in usage of the walker can be observed as 

they correlate to the gait. 

The dynamic model was developed with the intent to further analyze the efficacy of an 

automated control on the walker to decrease the pulling action required by the user. This work 

identified potential for the control of the automated walker to be based on the interaction of the 

user with the handles of the walker. A motorized walker could reduce the negative cost of the 

intervention while maintaining the positive effects of the posterior walker on posture and 

stability. Further use of this model will examine the effects of a motorized walker on gait 

outcomes in CP and the potential for increasing distance and time of ambulation.  
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Background & Literature Review 

2.1 Cerebral Palsy 

An international workshop defined CP in 2006 as “a group of permanent disorders of the 

development of movement and posture, causing activity limitation, that are attributed to non-

progressive disturbances that occurred in the developing fetal or infant brain. The motor 

disorders of cerebral palsy are often accompanied by disturbances of sensation, perception, 

cognition, communication, and behavior, by epilepsy, and by secondary musculoskeletal 

problems” (Rosenbaum et al., 2007). Cerebral Palsy (CP) has an incidence of approximately 1.5 

to 3.5 per 1000 live births (Cans, 2000; Winter, Autry, Boyle, & Yeargin-Allsopp, 2002; 

Yeargin-Allsopp et al., 2008) and lifetime costs are estimated near $1 million per person 

(Honeycutt et al., 2004). Listed below are known risk factors for CP in fetal and infant stages of 

life (Reddihough & Collins, 2003). 

• Antenatal: malformations in cortical development and maternal infections in first and 

second trimester 

• Perinatal: obstructed labor, multiple pregnancy, and birth weight 

• Neonatal: neonatal seizures, infections, and injuries 

These risk factors are associated with a singular central nervous system damage event 

occurring around birth which result in complications in motor function development. CP is non-

progressive in that it does not further deteriorate physiological functions through the lifetime of 

the person. Clinically, the progression of motor function development is observed in adolescents 

with a CP diagnosis. While the damage in the body is not increasing, the growth of the child can 

further aggravate symptoms of CP. A tight gastrocnemius muscle can become tighter when the 

leg grows, further decreasing motor function at the ankle and knee joint. It is important to 
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observe and analyze both the development of the child and the impact of interventions to have a 

positive or minimized negative effect on the motor function of the child. 

The analysis and treatment of CP is approached through the classification of the disorder 

through musculoskeletal and motor function assessments. Three sub-types of CP are used to 

categorize presentations of the disorder (Cans, 2000): 

• Spastic: increased tone and/or pathological reflexes 

• Ataxic: loss of orderly muscle coordination 

• Dyskinetic: involuntary, uncontrolled, and recurring movements 

Spastic CP accounts for approximately 70 to 80% of total CP cases (Yeargin-Allsopp et 

al., 2008) where it may present unilaterally or bilaterally in the upper and/or lower limbs (Cans, 

2000). The resulting abnormal motion in bilateral spastic CP of the lower limbs has been divided 

into four groups: true equinus, jump gait, apparent equinus, and crouch gait (Armand, Decoulon, 

& Bonnefoy-Mazure, 2016a). Of these, true equinus is characterized by the ankle in 

plantarflexion during stance phase and the hips and knees extended. Crouch gait is designated by 

excessive dorsiflexion at the ankle in concert with excessive flexion of the knee and hip joints 

(Figure 2.1). These gait patterns all result in the patient expending more energy to walk 

compared to a similar distance walked by a typically developed peer. Pathological gait patterns 

increase the load on the lower body joints which over time will cause pain and damage to the 

joints. Management of these gait abnormalities is important to alleviate pain in the short-term, 

increase gait efficiency, and prevent long-term damage.  
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Figure 2.1: Gait patterns observed in cerebral palsy along with affected muscle groups and AFO 

recommendations. Reprinted with permissions from Wiley and Sons Inc. (Rodda & Graham, 

2001). 

The gait patterns in spastic CP are best quantified through clinical gait analysis (Armand 

et al., 2016a). The pathologic gait of children with CP is analyzed as a critical indicator of their 

motor function which can help in advising patient-specific interventions. The Gross Motor 

Function Classification System (GMFCS) is widely accepted and utilized to provide quick 

classification criteria for clinicians and families to describe motor function and aid in clinical 

management decisions (Palisano, Rosenbaum, Bartlett, & Livingston, 2008). Gait analysis is a 

valuable tool for classification of CP both through the GMFCS and other assessments as it has a 
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greater accuracy than visual analysis (DeLuca, 1991; Gage, DeLuca, & Renshaw, 1996; Kienast, 

Bachmann, Steinwender, Zwick, & Saraph, 1999). 

CP directly affects the motor function of children with the disability, but downstream 

activities are also impeded. A study on the quality of life of children with CP reports that their 

disability inhibits their ability to create meaningful relationships with their peers (Colver et al., 

2015). The capacity of a child to move and play with their peers is affected by how much pain 

they experience as a result of CP; thus, it is important to engage in treatment options both for 

basic motor function and for social quality of life. 

 

2.2 Assistive Devices 

Intervention options for CP are considered based on the classification and analysis of 

each individual case. Invasive options such as botulinum toxin injections and surgical 

intervention are usually considered in cases with decreasing motor function with growth (Gough, 

Eve, Robinson, & Shortland, 2004; Paul, Siegel, Malley, & Jaeger, 2007) and often used in 

combination with orthotics and assistive devices. CP cases classified on the GMFCS scale from 

level I through level IV are often prescribed orthotics and/or assistive devices, whether invasive 

interventions were considered or not (Palisano et al., 2008). Children on the GMFCS scale at 

level II or III use assistive devices for the majority of the day for mobility across various terrains. 

Assistive devices have been proven to increase stability and decrease lower extremity load 

during movement (Fast et al., 1995; Yepremian et al., 2009). For a pathological gait that is 

typically unbalanced an assistive device provides independence in their mobility. 
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Figure 2.2: The Gross Motor Function Classification System for clinical evaluation of children 

aged six to twelve years old. (Burns et al., 2014)(Courtesy of Kerr Graham) 
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Figure 2.3: The Gross Motor Function Classification System for clinical evaluation of children 

aged twelve to eighteen years old. (Burns et al., 2014) (Courtesy of Kerr Graham) 
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Assistive devices, such as walkers and elbow crutches, have different preferential 

characteristics based on kinematic and energy expenditure effects of use as well as user 

preference (Bateni & Maki, 2005). Walkers assist in balance by providing steady stabilizing 

points of contact for the upper body. Elbow crutches are versatile and can be used on different 

terrains while providing dynamic support options. User preference for different devices 

influences the usage pattern for various aids (Lephart, Utsey, Wild, & Fisher, 2014) and in many 

instances preferences also align with the suggestion resulting from clinical gait and energy 

expenditure analysis. 

The effect on gait kinematics and energy expenditure is important in analyzing the 

efficacy of an assistive device. The gait of crutch users can vary greatly depending on their 

adaptation to the device (Thys, Willems, & Saels, 1996). This research potentially introduces 

new devices to users because this was not part of the exclusion criteria for subject recruitment; 

thus, elbow crutches do not provide consistent data between subjects. Posterior walkers assist 

balance and position the user to be more upright, with their center of mass directly in-line with 

their legs, whereas anterior walker use results in an anterior pelvic tilt and poor posture (B M 

Greiner, Czerniecki, & Deitz, 1993; Logan, Byers-Hinkley, & Ciccone, 1990; Park, Park, & 

Kim, 2001). Posterior walkers also may increase walking speed and step length (Bachschmidt et 

al., 2000) although not significantly in all studies (Park et al., 2001). An increase in walking 

speed and step length indicates a better adaptation to the device and a preferable subject-device 

kinematic interaction. 

Energy expenditure during motion, calculated from gait analysis, is significantly higher 

in CP cases when compared to their typically developed peers (Dziuba, Tylkowska, & 

Jaroszczuk, 2014; S. Russell, Bennett, Sheth, & Abel, 2011a; van den Hecke et al., 2007). It is 
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necessary for assistive devices to not add excessive energy cost in order to increase stability. 

Generally, anterior and posterior walkers increase oxygen consumption during ambulation 

(Holder, Haskvitz, & Weltman, 1993; Protas, Raines, & Tissier, 2007). In CP, posterior walkers 

are more efficient than anterior walkers when comparing oxygen cost and consumption rates 

(Park et al., 2001). 

 

2.3 Gait Efficiency Analysis 

The analysis of gait efficiency through energy cost metrics is used to quantify the effect 

of pathology and different treatment options in CP. Many studies have shown that energy use is 

significantly greater in children with CP than typically developed children (Bolster, Balemans, 

Brehm, Buizer, & Dallmeijer, 2017a; Norman, Bossman, Gardner, & Moen, 2004; Raja, Joseph, 

Benjamin, Minocha, & Rana, 2007). Metabolic energy consumption considers the whole body’s 

energy use and is measured through O2 consumption or heart rate. The measure of metabolic 

energy cost through O2 consumption is often used as the standard for comparison and viewed as 

the most accurate metric for gait efficiency. According to metabolic measures, children with CP 

use two to three times more energy than their typically developed peers (Bolster et al., 2017a; 

Ries & Schwartz, 2018). Norman (Norman et al., 2004) found energy expenditure index 

calculated from heart rate follows similar trends to O2 measurements. Heart rate measurement is 

typically less expensive and more practical in clinical CP analysis. Metabolic energy metrics 

quantify the whole-body cost and lack the ability to look at specific body segments. Some 

literature has tried to define specifically what causes this extra energy usage in CP gait through 

alternate energy expenditure analyses. Oxygen consumption is a delayed metric for measuring 

metabolic energy expenditure and only gives the whole-body energy usage. This work required 
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individual breakdown between segments of the body and between gait cycle events for in depth 

analysis of the kinetics. 

Unnithan et al. found the cocontraction of muscle groups plays a role in the increased 

energy cost in CP gait using electromyographic (EMG) data (Unnithan, Dowling, Frost, & Bar-

Or, 1996). EMG data yields individual data for muscle groups, but it can be difficult to quantify 

the whole-body muscle activation without significantly impeding the ambulation of the subject. 

Mechanical energy transfer has also been used to compare to metabolic energy cost, but a direct 

relationship has not been agreed upon in literature. Both mechanical work and metabolic cost 

increase with the degree of disability in CP (Dziuba et al., 2014; Johnston, Moore, Quinn, & 

Smith, 2004). Mechanical energy expenditure models can be further broken down into segments 

and joints of the body to more completely observe where energy cost may change due to 

pathology or assistive devices. Frost (Frost, Dowling, Bar-Or, & Dyson, 1997) had mixed results 

in comparing mechanical model outputs to metabolic energy cost. Their models did not 

incorporate kinetic data from the subjects and fell short of explaining a significant amount of 

change that was observed in metabolic energy cost. Van de Walle (Van de Walle et al., 2012) 

found the sum of the Vicon Plug-in-Gait model outputs for joint powers provided validity and 

sensitivity to pathologies like that of metabolic energy measures. By using mechanical energy 

calculations, this work was able to calculate the work of individual joints over the gait cycle.  

 

2.4 Modelling  

It is difficult to directly measure characteristics of motion in people and animals, but it is 

important to be able to quantify the loads and movements of the individual parts associated with 

the whole body. The human body can be represented as a mechanical system during walking. 



Chapter 2  13 

 
 

The study of a mechanical system requires the synthesis of a valid model in order to return 

parameter predictions from given input. Models give access to measures that cannot be recorded 

directly, for example joint moments and center of mass movement. For this work, a rigid body 

model was created to examine the effect of pathology and assistive technology on gait outcomes 

in walking. There are two general approaches to modelling human gait, inverse and forward 

dynamics. An inverse dynamics approach utilizes known kinematics to solve for musculoskeletal 

forces. In this work, inverse dynamic methods were used to predict joint movements and torques. 

Forward dynamics applies given joint torques and muscle forces to solve for gait kinematics. The 

model developed by this work sets up future work to run forward dynamics to tune and develop a 

controller for a powered walker in cerebral palsy gait. The controller for the powered walker will 

be tuned based on the kinematic model outcomes in order to increase the utility of the walker for 

the user. 

Many software packages offer the ability to create inverse dynamic models. While no 

model perfectly predicts the outcome, it is important to manage the assumptions made in the 

model to yield the results that are desired. The Vicon Plug-In-Gait (PIG) dynamic model is 

offered in addition to the Vicon motion capture system. Contacts can only be applied to the feet 

in the PIG model which would not allow the walker reaction forces to be included at the handles 

and wrists. The PIG model uses surface marker locations to approximate skeletal positions and 

orientations. Model outputs are calculated directly from these markers which presents multiple 

potential sources of error. Skin motion during ambulation introduces a skin artifact of high 

frequency motion at impact instances during gait and skin movement across muscles and bones. 

Because the markers can move independent of the skeletal frame they are tracking, the segments 

defined by the markers change length throughout a trial. Without further plugins and model 
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development, segments in the upper body of the Plug-In-Gait model are not as accurate and 

would require validation to look at kinetics (Stambolian, Asfour, & Eltoukhy, 2014). Vicon is 

inherently a closed code source and thus cannot be directly altered and tuned for specific models. 

The Vicon Plug-In-Gait dynamic model was not used in this work because it is most applicable 

for generic walking trials with ground reaction forces without additional model elements. 

An OpenSim inverse dynamic model examines the musculoskeletal outputs during gait 

(Delp et al., 2007; Pontonnier & Dumont, 2009; Todorov, Erez, & Tassa, 2012). Many dynamic 

models have been made in OpenSim and are publicly available and verified through use in 

multiple protocols. They are useful for analyzing specific muscle activation and joint torques. It 

is difficult to include multiple contacts in OpenSim models as computation time increases. 

OpenSim also has a limited selection of contacts for modeling. For these reasons, an OpenSim 

model was not used in this work.  

MSC Adams is a multibody dynamics solver software that is used in academic and 

industrial settings for research and product development. In MSC Adams a multibody dynamic 

model of the human gait can be created using the Generator of Body Data program (Baughman, 

1983). MSC Adams has multiple, robust contact models built in which this work needs in order 

to facilitate the modelling of the interaction of the human body and the walker and the body and 

the ground. Resultant models in MSC Adams can be queried for individual joint kinetics, center 

of mass movement, and other user-defined parameters. This work used MSC Adams LifeMod 

plug-in to develop an inverse dynamic model to examine mechanical work of the body under 

different gait conditions. 

In order to build a complete dynamic model of human gait the system movement and 

forces must be fully defined. Kinematics of the rigid bodies are needed to define movement in 
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the multibody dynamic model. The reaction forces of anything in contact with the body must be 

taken into account. This work incorporated ground reaction forces and walker handle reaction 

forces into the model of human gait. With a converged model, all the data is available for the 

joints and segments to do secondary analysis. 

Once the model of human gait including the walker has been verified, the impact of the 

walker on user motion can then be analyzed. Assistive devices increase stability in CP but also 

increase energetic cost on the user (Holder et al., 1993; Park et al., 2001; Protas et al., 2007). 

Applied torque at the wheels of a posterior walker could offset this negative effect of walker 

usage and a validated model would allow us to examine and predict the effect on movement. 
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Spatiotemporal Outcomes of Typical and Cerebral Palsied Gait: 

With and Without a Posterior Walker 

3.1 Introduction 

Cerebral Palsy (CP) is a group of disorders that affect motor and posture development 

caused by nonprogressive damage to the brain occurring near birth (Rosenbaum et al., 2007). 

Children with CP experience ranges of motor impairment due to muscle spasticity, weakness, 

and contraction control issues. During adolescence, CP can further affect children as they grow 

by tightening muscles and making ambulation difficult. Clinical intervention for CP is performed 

when it is seen to be most advantageous for the child’s motor development. Gait analysis has 

become a crucial outcome measure to assess CP gait and influence intervention options for 

children with CP. Spatiotemporal characteristics of the gait cycle have been used to compare 

between CP populations and typically developed (TD) peers (Ju Kim & min Son, 2014) as well 

as to observe the change or deterioration of motor function over time for individuals (Johnson, 

Damiano, & Abel, 1997).  

Clinical gait analysis is a powerful tool to aid in intervention and treatment of CP. It 

produces quantitative analysis of the gait cycle to provide specific data for clinicians on what 

muscle groups and joints are particularly affected by the individual case of CP. Johnson et al. 

observed that the velocity and stride length of children with CP decreased as the child grew 

(Johnson et al., 1997). This highlights the importance of interventions during adolescence to 

increase motor function. Prosser et al. showed that children with CP have lower walking 

velocity, cadence, step length, and percent of gait cycle in single support than their typically 

developed peers (Prosser, Lauer, VanSant, Barbe, & Lee, 2010). A smaller time in single support 

and smaller step length indicate a lower stability that children with CP have due to impaired 
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muscular development. Walking velocity and stride measurements decrease over time for 

children with CP and thus the deficit observed by Prosser et al. would only grow through 

adolescence. Comparing gait parameters between children with CP and typically developed peers 

highlights the different characteristics of gait in the two populations. This analysis can inform 

clinical interventions in CP with quantifiable values that can be tracked over time to show 

progression of motor function and development. 

Assistive walkers are typically recommended to increase stability and promote better 

posture of various users during gait (Bateni & Maki, 2005). Walkers provide stability to the torso 

through constant contact points to the ground and act to decrease the load on the lower body 

joints. Previous work has examined the effect of posterior and anterior walkers on CP gait. A 

posterior walker improves posture through lower flexion angles in the knees, trunk, and pelvis (B 

M Greiner et al., 1993; Logan, Byers‐Hinkley, & Ciccone, 1990) and lowers energy expenditure 

(Park et al., 2001) compared to gait with an anterior walker. Assistive devices have been shown 

to lower the cadence of the user compared to their gait without an assistive device (Krautwurst, 

Dreher, & Wolf, 2016a). Many positive effects from a posterior walker have been seen through 

spatiotemporal and posture analysis but a child with CP still has to pull the walker along to 

become more stable in their gait. The load of the walker inherited by the user has not been 

examined through quantifying the forces where the user and walker interact at the handles of the 

walker. 

Gait analysis in CP gait with a posterior walker has been limited and has not quantified 

the walker’s positive and negative impact on CP gait. Previous work has examined CP gait 

without assistive devices to define the differences from TD gait (Ju Kim & min Son, 2014; Pauk, 

Ihnatouski, Daunoraviciene, Laskhousky, & Griskevicius, 2016; Prosser et al., 2010). Krautwurst 
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et al. examined the effect of walkers on CP gait compared to baseline gait to inform the decisions 

of clinicians in surgical interventions for CP (Krautwurst et al., 2016a). Krautwurst et al. 

calculated velocity, cadence, step length, and step width as spatiotemporal metrics of gait. 

Previous work has focused on the effect of a few metrics on one feature of gait as opposed to a 

larger scope which more fully defines the effect of the walker on gait. No one has quantified the 

full effect of posterior walkers on spatiotemporal parameters and mechanical load on the body in 

CP gait compared to unassisted gait. 

This work developed a method to quantify the positive and negative effects of a posterior 

walker used in CP gait. This was done through calculation of spatiotemporal characteristics for 

TD and CP children while walking with a posterior walker and without an assistive device. Over 

the gait cycle, calculated values include: stride length, stride time, cadence, velocity, step length, 

foot off and contact percentages of gait cycle, and single and double support percentages. 

Ground and walker handle reaction forces were analyzed to further define how the walker was 

used for support. The results are critical indicators of stability and balance in dynamic gait and 

were used to compare within populations to examine the effect of the walker on gait. 

Comparisons between populations then examine the incorporation of the walker into pathologic 

and TD gait. It is expected that the spatiotemporal parameters and ground reaction forces would 

align with what has been reported in previous literature under similar gait conditions. The handle 

reaction forces will show the reliance of the users on the walker and how the walkers were used 

by different groups. 
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3.2 Methods 

3.2.1 Subjects and Procedure 

The kinematic data for 17 children was collected in the Motion Analysis and Motor 

Performance Laboratory at the University of Virginia. There were two populations represented 

within the group. The first was composed of 8 children with a diagnosis of spastic, diplegic 

Cerebral Palsy (CP). The second group of 9 children consisted of controls with no known 

musculoskeletal pathologies. The group with CP had prescribed ankle foot orthotics (AFOs) and 

wore them during testing. Six of the children had a GMFCS of III, two typically used a walker to 

move. Four children used forearm crutches regularly for movement in the community. The other 

two children had a GMFCS II and did not require assistive devices except for long-distance 

settings. The children were community ambulators and had ranges of experience with assistive 

devices. The children were asked to walk over the short distance of the testing area without the 

aid of an assistive device. Four children with a GMFCS III used crutches to walk for the baseline 

trials and one child used a walker for baseline trials. The data for the subject who used a walker 

in baseline trials was not used for spatiotemporal analysis because it was assumed the results 

would be similar between baseline and the custom walker gait. The data for the instrumented 

walker was used later in the study for analysis. Subject assent and parental consent were 

approved by the University of Virginia’s Human Investigation Committee and were obtained for 

all subjects. 

A full body marker set of 38 kinematic markers following the Plug-in-Gait marker set 

was attached to all subjects. Subjects walked along a straight path for 15 meters at their self-

selected comfortable walking speed. Three-dimensional kinematic data were collected using a 

12-camera Vicon Nexus Motion Capture System (Oxford Metrics, UK) sampling at 100Hz. 
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Ground reaction force (GRF) was collected with five Bertec force plates sampling at 1000Hz. 

The force plates were embedded in the floor in the center of the path for each trial. Each subject 

completed a minimum of three trials for each walking condition where two sequential steps were 

labelled for events of foot strike and foot off. The first condition for walking was a baseline, 

where the subject walked without any device aid other than their AFO’s if prescribed or with 

crutches as necessary. For the second condition the children were instructed to walk with an 

instrumented, pediatric posterior walker. A typical posterior walker was instrumented at both 

handles with a 6 DoF load cell (ATI) to capture all forces (1000Hz) applied through the handles. 

The walker wheels were designed wide enough to avoid interference with force plate readings of 

GRFs. To correct for periodic interference when subjects walked off the center line down the 

walkway, MATLAB code was written to cancel out the interference of the walker. The code 

defined the location of the walker wheels and defined time periods when the walker was on a 

force plate. The vertical forces on the handles and the weight of the walker were combined to 

subtract from the GRF if interference was occurring. Subjects with no prescribed AFOs walked 

barefoot for all trials and those with prescribed AFOs wore their AFOs and shoes. Prescribed 

AFOs were worn for all baseline and walker-assisted trials. The data collected in Vicon was 

processed with the Nexus program where a total of 7 gait cycle events were labelled: foot strike, 

contralateral toe off, contralateral foot strike, toe off, foot strike, contralateral toe off, and 

contralateral foot strike. Events were labelled using recorded force plate data over the trial. Foot 

strike occurred when the vertical force on the respective plate was greater than a 15 N threshold. 

Toe off was marked when the vertical force fell below the 15 N threshold. 
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3.2.2 Spatiotemporal Analysis 

Spatiotemporal analysis was conducted for trial outputs as presented in previous work 

from kinematic data (Johnson et al., 1997; Ju Kim & min Son, 2014; Pauk et al., 2016). Stride 

length for the left and right leg stride were calculated as the distance travelled by the respective 

foot between the first and second heel strike of the same foot. The two locations of the foot were 

calculated as the average of the ankle, heel, and toe markers at the heel strike time points. Stride 

length was normalized by the length of the respective leg so that the results could be compared 

across different subjects. Step length for the left and right step was calculated as the distance 

from the contralateral to the ipsilateral foot at heel strikes of the respective feet. The location of 

the feet was the average of the three foot markers on the foot. Step length was normalized by the 

length of the respective leg for which the step was taken. 

Stride time was calculated as the period from initial heel strike to terminal heel strike and 

reported in seconds (Figure 3.1). The cadence was calculated as the inverse of the stride time and 

converted to steps per minute. Velocity was calculated by dividing the non-normalized stride 

length by the stride time.  
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Figure 3.1: Gait cycle events and terminology. 
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Contralateral foot off and contact and ipsilateral toe off events were calculated as a 

percentage of the gait cycle from initial to terminal heel strike. Two values for each parameter 

were generated for each trial as left and right strides were used for this analysis. Single and 

double support time for both left and right strides were calculated using events labelled from 

force plate data. Single support time was calculated from adding the time period between 

contralateral toe off and contralateral foot strike and the time period between ipsilateral toe off 

and ipsilateral foot strike. Double support time was calculated by adding the time period between 

initial foot strike and contralateral toe off and the time period between contralateral heel strike 

and ipsilateral toe off. Single and double support were calculated as a percentage of the gait 

cycle by dividing the time of support by the respective stride time for the left and right stride. 

Parameters were compared using statistical t-tests where the samples were assumed to 

have equal variance for comparing within groups and unequal variances for comparisons 

between groups. 

 

3.2.3 Reaction Forces 

The ground and walker handle reaction forces were recorded for baseline and walker-

assisted gait trials. Posterior walkers reduce the load on the lower body joints in populations 

which rely on the walker for ambulation (Bateni & Maki, 2005; Fast et al., 1995). The GRF was 

examined so that the reliance on the walker could be quantified at different times over the gait 

cycle. A greater reliance on the walker would present as a lower magnitude GRF over the gait 

cycle. Handle reaction forces were examined to define the dependence on the walker and the 

applied force to move the assistive device by each group. The CP group was expected to have a 
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higher reliance on the walker and use more force to move the walker along through their gait 

cycle. 

 

3.2.4 Statistical Parametric Mapping 

Baseline and walker trial outputs for reaction forces were compared using one-

dimensional statistical parametric mapping (SPM) originally designed for neurological testing 

(Friston, Ashburner, Kiebel, Nichols, & Penny, 2011). SPM has been shown to be a valuable 

statistical test for biomechanical comparisons by Pataky in a series of studies and SPM1D 

software interface in Python and Matlab (Pataky, 2010, 2012). SPM analysis performs better 

over time periods than individual tests of each point because it considers the surrounding data 

points in calculating the p-value in post hoc analysis (Pataky, Robinson, & Vanrenterghem, 

2016). SPM allowed for the comparison of ground reaction forces and walker handle reaction 

forces over the gait cycle and identified time periods where walker-assisted gait deviated from 

baseline gait. 

 

 

3.3 Results 

3.3.1 Subjects 

Subject anthropometrics were recorded during collection and are presented in Table 3.1. 

Body Mass Index was calculated based on subject mass, height, and age. Two groups were 

created to compare outcomes, one group of children with a diagnosis of cerebral palsy (CP) and 

another of typically developed (TD) peers as a control group. A range of children and young 

adults participated in the study for both groups. Through t-test comparison, weight (p=0.019) and 
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height (p=0.049) were different between the groups. This is indicative of the differences between 

the populations, but for the purposes of this work the populations were considered similar as 

significance was not found in age or body mass index (BMI).  
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Table 3.1: Subject Anthropometrics. Significance between TD and CP groups is marked as 

* (p<.05), ** (p<0.01), *** (p<0.001). 

Group Age (years) Weight (kg) Height (cm) BMI 

TD 16±5.4 57.4±20.4 160.6±19.7 21.2±4.8 

CP 13.5±2.4 36.2±5.6 * 144.0±6.6 * 17.2±2.1 
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3.3.2 Spatiotemporal Gait Parameters 

The effect of a pediatric posterior walker on gait was quantified through spatiotemporal 

parameters (Table 3.2). Comparisons were also made between TD and CP groups to quantify the 

pathology of gait. One CP subject with a GMFCS of III was excluded from the analysis because 

they were unable to walk in their baseline trial without their own walker that they used on a daily 

basis. There was no significant difference in stride length between CP subject self-selected most 

and least affected limb so sides were combined for all data reported. The CP group was less 

stable and walked worse than the TD group in baseline trials based on the calculated 

spatiotemporal parameters. Normalized stride length was shorter in the CP group compared to 

the TD group when walking under normal conditions (p<0.01). The CP group walked at a lower 

velocity than the TD group for baseline gait (p<0.01). The CP group also spent more time in 

double support indicating a less stable gait. 

The TD and CP groups also had significantly different parameters when walking with the 

walker as compared to their baseline walk. Velocity and stride length were worse for the TD 

group when walking with the walker. The CP group had no significant changes to their gait when 

walking with the walker but they trended towards walking slower. The TD group had shorter 

strides when walking with the walker than in their baseline trials. Percentage of time in single 

and double support were not different for either group.  
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Table 3.2: Spatiotemporal Parameters. All metrics are significant between TD and CP except 

opposite foot contact. Significance between baseline and walker trials is marked as * (p<0.05), 

** (p<0.01), *** (p<0.001) and TD to CP marked as □ (p<0.05), □□ (p<0.01), □□□ (p<0.001). 

Parameter Type TD (n=9) CP (n=7) 

   Parameter Baseline Walker Baseline Walker 

Spatial     

   Stride Length (m) 1.29±0.15 1.17±0.17 0.92±0.17□□□ 0.88±0.09 

   Normalized Stride Length 1.54±0.13 1.39±0.12* 1.20±0.18□□ 1.15±0.14 

   Step Length (m) 0.63±0.07 0.58±0.08 0.45±0.08□□□ 0.42±0.04 

   Normalized Step Length 0.75±0.06 0.69±0.06* 0.58±0.08□□□ 0.56±0.06 

   Velocity (m/s) 1.23±0.11 1.07±0.14* 0.83±0.27□□ 0.68±0.16 

Temporal (gc = gait cycle)     

   Single Support (% of gc) 77.9±3.40 77.3±3.28 71.4±5.36□ 72.7±6.24 

   Double Support (% of gc) 22.1±3.40 22.7±3.28 28.6±5.36□ 27.3±6.24 

   Stride Time (sec) 1.05±0.08 1.10±0.08 1.18±0.32 1.36±0.32 

   Cadence (step/min) 115.1±9.7 110.3±8.4 107.3±24.6 92.6±20.5 

   Single Support (sec) 0.82±0.05 0.85±0.05 0.84±0.19 0.98±0.21 

   Double Support (sec) 0.23±0.05 0.25±0.05 0.35±0.14 0.38±0.14 

   Opposite Foot Off (% of gc) 11.1±1.68 11.2±1.78 14.1±2.74□ 13.8±3.26 

   Opposite Foot Contact (% of gc) 49.9±0.25 50.0±0.26 49.9±0.54 50.2±0.80 

   Toe Off (% of gc) 60.9±1.67 61.6±1.46 64.4±3.06□ 63.7±3.37 
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The CP group was composed of a broad range of children with different GMFCS levels 

and different assistive device needs. For comparison between these subgroups, two groups were 

made based on their GMFCS level (Table 3.3). Two subjects had a GMFCS score of II and five 

subjects had a GMFCS score of III. Ranges for the GFMCS II group were reported as an average 

and standard deviation would not be representative. In baseline trials, the GMFCS II subgroup 

walked with greater velocity and lower stride time in their baseline gait compared to the whole 

CP group. Their stride and step lengths were also longer than the whole CP group. With the 

incorporation of the walker into their gait, the GMFCS II subgroup walked slower and with a 

shorter stride length. In walker-assisted gait, the percentage of time spent in single support 

decreased for the GMFCS II subgroup.  

The GMFCS III subgroup walked slower and took shorter strides than the whole CP 

group. During walker-assisted gait the GMFCS III subgroup was more stable as they walked 

with an increased percentage of time in single support. The increase in single support resulted 

from earlier toe off times and no change in contralateral contact times over the gait cycle. Stride 

length trended towards being longer and velocity trended towards being slower in walker-

assisted gait but was not significant. 

The CP group with GMFCS III was further separated by the type of assistive device used 

for ambulation in their baseline trials in addition to their prescribed AFOs (Table 3.3). The 

subgroup that used crutches on a daily basis also used crutches in their baseline walk. No 

changes were significant in the “Crutches” subgroup (CS) when walking with the walker as 

compared to walking with crutches but the group size was small and trends were observed. The 

CS walked slower than the whole group and reciprocal effects on temporal parameters were 

calculated. Normalized stride length was also shorter in the baseline trials compared to the whole 
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CP group. When walking with a walker, the CS group increased the percentage of time they were 

in single support. The ipsilateral and contralateral toe off events occurred earlier in the gait cycle 

and shortened the time in double support.  
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Table 3.3: Spatiotemporal Parameters for subgroups of CP group based on GMFCS level. Significance between baseline and walker 

trials is marked as * (p<0.05), ** (p<0.01), *** (p<0.001) and baseline CP total to CP subgroup marked as □ (p<0.05), □□ (p<0.01), □□□ 

(p<0.001). 

Parameter Type GMFCS II (n=2) GMFCS III (n=5) Crutches (n=3) 

   Parameter Baseline Walker Baseline Walker Baseline Walker 

Spatial 
    

  

   Stride Length (m) 0.96-1.27 0.89-0.99 0.84±0.07 0.86±0.10 0.87±0.02 0.90±0.08 

   Normalized Stride Length 1.34-1.50 1.17-1.23 1.11±0.10 1.14±0.17 1.12±0.10 1.16±0.20 

   Step Length (m) 0.47-0.60 0.42-0.48 0.41±0.03 0.41±0.04 0.42±0.01 0.43±0.04 

   Normalized Step Length 0.65-0.71 0.57-0.58 0.54±0.05 0.55±0.08 0.54±0.05 0.55±0.10 

   Velocity (m/s) 0.96-1.32 0.62-0.84 0.71±0.15 0.66±0.18 0.61±0.12 0.63±0.24 

Temporal (gc = gait cycle)       

   Single Support (% of gc) 67.6-78.4 61.0-71.6 70.8±5.20 75.2±3.99 68.9±6.04 75.3±5.62 

   Double Support (% of gc) 21.6-32.4 28.4-39.0 29.2±5.20 24.8±3.99 31.1±6.04 24.7±5.62 

   Stride Time (sec) 0.96-1.01 1.18-1.46 1.26±0.35 1.38±0.38 1.47±0.28 1.54±0.41 

   Cadence (step/min) 118.9-124.7 83.5-102.0 101.4±27.5 92.6±24.3 84.1±16.2 83.1±25.3 

   Single Support (sec) 0.68-0.76 0.84-0.89 0.88±0.21 1.03±0.24 1.00±0.17 1.14±0.24 

   Double Support (sec) 0.21-0.33 0.34-0.57 0.38±0.16 0.35±0.14 0.46±0.15 0.40±0.18 

   Opposite Foot Off (% of gc) 10.6-15.8 14.5-19.8 14.4±2.70 12.4±2.11 15.3±3.25 12.4±2.89 

   Opposite Foot Contact (% of gc) 49.7-49.9 51.0-51.1 49.9±0.66 49.8±0.62 50.0±0.66 49.9±0.71 

   Toe Off (% of gc) 60.7-66.5 65.1-70.2 64.7±3.08 62.2±1.74 65.8±3.43 62.2±2.44 
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3.3.3 Reaction Forces 

Average GRFs over the gait cycle were compared between baseline and walker trials 

within groups. Average handle reaction forces for the walker assisted trials were splined to the 

length of the gait cycle for each group and plotted on a second axis alongside the GRFs. SPM 

analysis was performed to find differences between the average GRFs for both groups. The TD 

group walked with lower magnitude GRFs in all three directions when walking with the walker 

(Figure 3.2). Peak vertical GRF was lower during weight acceptance and in preparing for toe off 

for the TD group. Similar effects were observed over the same ranges for lateral and longitudinal 

forces in the TD group.  

The CP group had a lower peak vertical force during loading in stance phase (Figure 3.3). 

Lateral GRF was lower over the terminal stance phase. Vertical loading on the walker was 

greater and more variable in CP gait compared to TD gait. Cyclical loading occurred in the 

vertical and longitudinal directions in the CP group with maxima during double support times 

following ipsilateral and contralateral foot strikes. The TD group applied comparably constant, 

low-magnitude forces to the walker. 
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Figure 3.2: TD group 3-dimensional ground reaction forces over gait cycle. Significance 

between baseline (black and gray) and walker (blue) trials highlighted by blue shaded boxes. 

SPM significance marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***). Toe-off time marked 

by vertical lines for baseline (black) and walker assisted (blue) trials.  

  

*** *** *** 

*** *** 

*** *** 
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Figure 3.3: CP group 3-dimensional ground reaction forces over gait cycle. Significance 

between baseline (black and gray) and walker (blue) trials highlighted by blue shaded boxes. 

SPM significance marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***). Toe-off time marked 

by vertical lines for baseline (black) and walker assisted (blue) trials.  

*** 

*** 
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The CP group was separated into subgroups by GMFCS score and by assistive device 

used in baseline trials. The Crutches subgroup was created from members of the GMFCS III 

subgroup and provided further knowledge of the CP group as a whole. GRFs for baseline and 

walker-assisted gait and handle reaction forces for walker-assisted gait were examined within the 

subgroups (Figure 3.4). Vertical GRF was lower in all subgroups at the initial peak near the 

occurrence of contralateral foot off. The walker was loaded more vertically and laterally in the 

GMFCS III and Crutches subgroups compared to the GMFCS II subgroup. Further cyclical 

interaction with the walker was observed in the GMFCS III and Crutches subgroups. Vertical 

handle reaction force was greatest at ipsilateral and contralateral heel strikes. In the longitudinal 

direction peak force pulling the walker forward occurred during double support time following 

heel strikes during the gait cycle. The GMFCS II group applied forces to the walker that were 

greater than the TD group, but no significant pattern of use was evident.  
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Figure 3.4: Average ground reaction forces for subgroups: GMFCS II (left), GMFCS III (middle), and Crutches (right) over a gait 

cycle for baseline (black and gray) and walker-assisted (blue) trials for the left oriented y-axis scale. The handle reaction forces (red) 

for walker-assisted gait are shown with the corresponding y-axis scale on the right. Toe-off time marked by vertical lines for baseline 

(black) and walker assisted (blue) trials. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), 

and p<0.001 (***).  

*** *** 

*** *** 

*** 

*** 
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3.4 Discussion 

Spatiotemporal gait parameters were used as outcome measures for analysis of the effects 

that posterior walkers have on TD and CP gait. The effect of pathological gait was seen by 

comparing baseline TD and CP gait. The incorporation of the walker into subject gait was 

examined by comparing the similarities and differences in spatiotemporal parameters between 

the two groups as well as reaction forces from the ground and handles of the walker. The TD 

group was inhibited by the walker as spatiotemporal parameters were worse in their gait with a 

walker. The whole CP group walked slower and had a shorter cadence in walker-assisted gait but 

was not as greatly affected by the walker on average as the TD group. Breaking the CP group up 

by GMFCS level revealed effects of the walker on the different groups within the CP group more 

decisively. The GMFCS II group experienced similar deleterious effects as the TD group which 

was expected as they would not typically be prescribed a walker for movement aid. The GMFCS 

III group increased their stability by walking with more time spent in single support with the 

walker compared to their baseline gait. They also applied more supporting force to the walker 

than the GMFCS II group. This analysis highlights the utility of the GMFCS for identifying 

populations of children with CP who can benefit from a posterior walker and separate those who 

would not be positively affected. The spatiotemporal parameters and reaction forces show a 

broad view of the walker’s effect on gait and further analysis is performed in later chapters. 

In baseline trials, most spatiotemporal parameters were significantly different (p<0.05) 

between the TD and CP groups. The results for stride length, velocity, and cadence agree with 

previous work (Armand, Decoulon, & Bonnefoy-Mazure, 2016b; Brégou Bourgeois, Mariani, 

Aminian, Zambelli, & Newman, 2014; Ju Kim & min Son, 2014), falling within the ranges of the 

presented values. A decreased velocity noted in the CP group was primarily a result of a 
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decreased stride length. A lower cadence in CP gait also contributed to a lower velocity but the 

standard deviation of the CP group was very large and previous work has found mixed results on 

whether cadence is as much a contributor to overall velocity as stride length. 

Temporal events also showed significance between the TD and CP groups. The control 

group performed similar gait patterns to that presented by Schwartz et al. (Schwartz, 

Rozumalski, & Trost, 2008). The CP group had a later occurrence of contralateral and ipsilateral 

foot off. The longer relative time until toe off for the CP gait cycle increases the time in double 

support indicating the need for more stability and balance with two points of contact with the 

ground. Children with CP are inherently less balanced and in control of their motor functions. 

The CP group showed an increase in double support time and decrease in velocity and stride 

length to enable a stable gait over the test area. 

The CP group was split by GMFCS classification between II and III. The GMFCS II 

subgroup walked faster, at a faster cadence, and with longer strides than the whole CP group in 

baseline trials. The GMFCS III subgroup walked at a slightly slower speed and with a shorter 

stride length than the whole group. The GMFCS II subgroup was expected to walk with a greater 

velocity and longer stride length as this indicates a more stable gait in the population less 

affected by CP. While the subgroups differed in velocity, cadence, and stride length, they had 

similar gait event occurrence times and thus single and double support times.  

The CP group was split into subgroups where the baseline walk was performed with 

assistive walking crutches and without additional support outside of prescribed AFOs. The CS 

group had a lower normalized stride length than the whole group. While using the crutches for 

assistance, the length of the CS group’s stride was limited by the cyclical placement of the 

crutches on the ground. Velocity and cadence were also negatively affected by using the crutches 
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compared to the whole CP group. By breaking the CP group into subgroups by device used in 

baseline trials and GMFCS score, expected differences were observed but important similarities 

were also found. Particularly, the time spent in single and double support by all subgroups was 

similar to the whole group. This metric was used as a critical indicator of stability when the 

walker was introduced into the subject’s gait. An increase in stability would be indicated by an 

increase in time spent in single support. 

Posterior walkers and other assistive devices are used by many populations to increase 

stability by providing additional ground contact points throughout ambulation. Stride length, 

velocity, and cadence were all lower in walker-assisted gait for the TD group. The CP group 

showed similar trends in the stride parameters in walker-assisted gait except the stride length did 

not change. These values agree with that presented in previous work (Krautwurst et al., 2016a; 

Park et al., 2001). Along with the stride parameters, both group’s total stride time was greater 

(p=0.005). The walker inhibited the gait of children with CP and TD children which is shown 

through the lower average velocity but it did not change the percentage of time spent in single 

support for either group. The time in single support for CP gait was greater in walker-assisted 

trials but the percentage of time spent in single and double support did not change, but by 

breaking up the CP group further analysis showed expected differences. 

The GMFCS II group was negatively affected by the posterior walker. A shorter stride 

length, lower velocity, and shorter percentage of time in single support indicate the low utility 

the GMFCS II group received from the walker based on spatiotemporal parameters. The GMFCS 

III group increased time spent in single support but trended towards walking slower and with 

worse cadence. Walker-assisted gait was better than crutch-assisted gait for subjects who used 

crutches on a daily basis. Although the CS group typically did not use a walker, the walker 
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enabled a more stable gait than walking with their crutches. Overall, a posterior walker had 

mixed effects on gait in the CP group, the GMFCS III users who would typically be prescribed a 

walker experienced both positive and negative effects on spatiotemporal metrics. To further 

define the walker interaction, ground and walker handle reaction force was compared between 

baseline and walker-assisted gait. 

GRFs for TD and CP groups were different in vertical, lateral, and longitudinal 

directions. The TD group velocity with the walker was lower (p<0.001) compared to baseline 

and the changes in the TD group GRFs are characteristic of children walking with lower velocity 

(Schwartz et al., 2008). The CP group presented lower magnitude GRFs compared to baseline. 

The differences were similar to the TD group changes and the CP group also walked with a 

lower velocity (p<0.001) when using the walker than in baseline trials. While the changes seen in 

the GRFs could be attributed to the velocity decrease in walker trials, the handle reaction forces 

revealed a difference in how the two groups incorporated the walker in their gait. The TD group 

applied relatively constant force in all three directions to the walker over the gait cycle, which 

was expected as the walker does not increase the gait efficiency or stability through the TD 

group relying on it during their gait. The CP group applied greater and more variable downward 

force to the walker, indicating the reliance of the children with CP on the walker for cyclical use, 

thus decreasing the load on the lower body. The longitudinal force was relatively constant 

throughout the gait cycle except for time periods right after heel strike where the force peaked. 

The increased longitudinal force to pull the walker along coincided with the double support time 

for the CP group. The CP group used the walker as a relatively static support for their gait during 

single support and pulled the walker during times of greater stability in their gait. 
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The GMFCS III and CS groups had lower initial peak vertical GRF in walker assisted 

gait and cyclically loaded the walker vertically and longitudinally. Decreased vertical ground 

reaction forces were expected because the groups walked slower in walker-assisted gait than in 

baseline (Schwartz et al., 2008). The CP subgroups had greater magnitude decreases in peak 

vertical ground reaction forces than what is explained by their decrease in velocity and this can 

be attributed to their reliance on the walker. The subgroups relied on the walker most at heel 

strike and trended lower during double support followed by increased vertical loading during 

single support. GMFCS III and CS groups pulled the walker most during double support times. 

For the subgroups that relied on the walker, cyclic patterns of use were observed and loading on 

the walker coincided with gait event times associated with single and double support. This usage 

pattern is ideal for designing an intelligent motorized controller based on these forces to decrease 

the need for longitudinal pulling of the walker. The effect of the walker on the GRF of the 

GMFCS II group was like that seen in TD gait as the GRF was decreased in all directions. The 

GMFCS II group relied on the walker for load bearing by vertical loading but no cyclic pattern 

was observed. The walker was not positively incorporated into the gait of the GMFCS II group 

as they did not interact with it in a cyclic way. From this analysis, the GMFCS II subgroup did 

not need the walker, but relied on it for support throughout the gait cycle to the detriment of their 

velocity, stride length, and single support time. The subgroups have a lower sample size so it is 

likely that with a larger group there would be a more observable effect of the walker on reaction 

forces of the subgroups. 

Overall, walker-assisted gait in the TD group was worse than baseline and the results 

show that the walker potentially makes the user less stable and unbalanced. The control group 

was not expected to use the walker for support, the spatiotemporal parameters were expected to 
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change in walker-assisted gait and possibly contribute to an abnormal gait pattern. The CP group 

showed similar trends in spatiotemporal parameters between baseline and walker trials as the TD 

group. The CP group used the walker for support through downward force on the walker 

throughout the gait cycle. Longitudinal force applied by the CP group was low except during 

double support time where children with CP were most stable and pulled the walker along for the 

next static period where the longitudinal force is lower. The CP group (n=9) could lack power in 

some parameters as higher standard deviations occurred compared to the TD group. This is likely 

due to the broad group of children with spastic, diplegic CP that volunteered for the study and 

the nature of the pathologic gait presenting more variably than TD gait. Time in single support 

increased for both groups which indicates a more stable gait but the percentage of the gait cycle 

spent in single support was not significantly greater. There were mixed results as to the positive 

effects of the walker on gait in both groups. 

The walker had similar effects on spatiotemporal parameters of both groups to different 

degrees and thus it was difficult to fully define the utility of walker-assisted gait in pathologic 

gait with spatiotemporal parameters alone. Subgroups within the whole CP group were positively 

and negatively affected by the walker in how much time they spent in single and double support. 

Negative effects of the walker on gait were evident from spatiotemporal parameters in all 

subjects. The force applied to the walker offered a glimpse into how the TD and CP groups differ 

in walker-assisted gait. There was no conclusive evidence that the walker had any positive effect 

on gait for either whole group, although the GMFCS III and CS subgroups had better stability 

and balance in walker assisted gait while they also cyclically used the walker for support and to 

pull it along during their gait. 
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3.5 Conclusion 

The spatiotemporal analysis in TD and CP groups quantified the difference in various 

gait characteristics between and within the populations. Results confirmed previous work that CP 

gait is generally less stable without assistive devices compared to TD peers and that velocity 

during gait is typically lower in CP. Differences within populations were also observed when 

walking with and without a pediatric posterior walker. As they are currently designed, walkers 

benefit a small subgroup of children with CP while for other groups the walker offers some 

benefit but also some detriment. This work helps to identify these groups and offers information 

that could influence the future design of a better walker. The results presented in this work are 

only a piece of how the walker’s effect can be quantified. More on the walker’s effect on gait 

will be discussed in Chapter 4 using model outputs for joint kinematics and kinetics.  
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Posterior Walker-Assisted Gait of Children With and Without 

Cerebral Palsy: Kinematics and Kinetics 

4.1 Introduction 

Children with CP typically are often prescribed posterior walkers to enable more stable 

gait and better posture. The positive effects of a posterior walker must outweigh the negative 

effects for the user to willingly incorporate it into their gait, but previous work has not quantified 

the full effect of a posterior walker gait. In Chapter 3, spatiotemporal characteristics revealed a 

generally negative effect on gait in both CP and TD groups. The GMFCS III subgroup walked 

with more time in single support with the walker than without and applied cyclic forces to the 

walker. Previous work has looked at the joint kinematics of the lower body and torso joints 

during gait to quantify posture (Brooke M. Greiner, Czerniecki, & Deitz, 1993; Krautwurst et al., 

2016a; Logan, Byers-Hinkley, et al., 1990). In the clinical setting, some measurements are harder 

to accomplish directly. A model can be utilized to calculate joint kinematics and kinetics and 

examine the walker’s effect on posture and overall gait with the data that was collected. No 

previous work has been able to perform full body kinetics on gait with a walker, this work 

developed a full kinetic model for gait with a posterior walker. Model utility for clinical gait 

analysis is dependent on the simplifying assumptions used to perform the dynamic analysis in the 

model. 

Many different models have been created for pathologic gait to measure body segment 

dynamics. Vicon Nexus incorporates the conventional gait model (CGM) that has been used for 

many applications in gait analysis (Baker, Leboeuf, Reay, & Sangeux, 2017). The CGM relies on 

kinematic markers to model full body movement. The segments of the body change 

characteristic length and orientation based on marker movement during gait. The upper body 
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model has not been validated using the CGM and this work requires an upper body model to 

complete the analysis. For these reasons the CGM formulation in Vicon Nexus’s Plug-in-Gait 

model was not used. Baker et al. propose that inverse kinematic models are more suitable to 

clinical gait analysis (Baker et al., 2017). A rigid body model performs better in dynamic 

simulations by applying forces and torques to segments which don’t change defining 

characteristics from frame to frame. 

Inverse kinematic models use rigid bodies to represent body segments and drive the 

motion of the body through an optimization technique to minimize errors between the body’s 

position and the measured kinematic markers. The kinematic markers do not dictate the exact 

movement of the body as they do in CGM but instead contribute to the model’s calculations for 

minimizing the error between measured and expected kinematic marker positions to drive 

motion. Seth et al. describe an inverse kinematic, musculoskeletal model in OpenSim to observe 

muscle group activation in normal and pathological gait (Seth, Sherman, Reinbolt, & Delp, 

2011). Musculoskeletal models in OpenSim examine lower body, upper body, or specific muscle 

groups but typically do not look at the whole body with all the incorporated musculoskeletal 

elements as it would be computationally inefficient. Additionally, OpenSim does not have a 

robust computational system to manage contact forces aside from ground contact forces. In this 

work, along with the analysis of the body’s kinematics, the interaction of the body with the 

ground and with a posterior walker was modelled. In OpenSim, the necessary contact forces 

could not be easily developed to model the necessary interactions. Alternate approaches were 

considered which could quantify whole-body kinetics and perform individual segment analysis. 

Observation of muscle activation and force was outside of the scope of this work. 
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MSC Adams is a multibody dynamics solver software capable of inverse kinematic and 

kinetic modelling of systems that is used in academic and industrial settings for research and 

product development. In MSC Adams a multibody dynamic model of the human gait can be 

created using the Generator of Body Data program (Baughman, 1983). MSC Adams has 

multiple, robust contact models built in which this work required in order to facilitate the 

modelling of the ground contact force and walker handle contact force on the body. Inverse 

kinematic simulations in MSC Adams act to minimize the energy in spring-damper systems 

between measured and modelled kinematic markers to accomplish the motions with the given 

constraints of the system. Resultant models in MSC Adams can be queried for individual joint 

kinetics, center of mass movement, and other user-defined parameters. Additionally, Adams and 

Matlab Simulink have a co-simulation environment where dynamics and controllers can be 

developed and implemented. This will be used in future work to develop a controller for 

automating the walker to further increase the benefit to the user. This work used MSC Adams 

with the LifeMod plug-in to develop a dynamic model (S. Russell, Bennett, Sheth, & Abel, 

2011b). 

In this chapter, the methods used to create a dynamic walking model of human gait with 

the addition of an instrumented posterior walker are detailed. Subjects walked under two 

conditions: their typical walk (baseline) and gait with a posterior walker. The posterior walker 

was instrumented in a similar manner to the method of Konop et al. (Konop et al., 2009). Full 

body kinematics and kinetics were examined over a gait cycle for both TD and CP groups. 

Posture analysis was performed by examining joint flexion-extension angles at specific time 

points during gait and comparing to baseline TD gait which was assumed to have an optimal 
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posture for gait. Through validating the model, we can quantify kinetics of the body which has 

not been done in previous work. 

 

4.2 Methods 

4.2.1 Subjects and Procedure 

The kinematic data for 17 children was collected in the Motion Analysis and Motor 

Performance Laboratory at the University of Virginia. There were two populations represented 

within the group. The first was composed of 8 children with a diagnosis of spastic, diplegic 

Cerebral Palsy (CP). The second group of 9 children consisted of controls with no known 

musculoskeletal pathologies. The group with CP had prescribed ankle foot orthotics (AFOs) and 

wore them during testing. Six of the children had a GMFCS of III, two typically used a walker to 

move. Four children used forearm crutches regularly for movement in the community. The other 

two children had a GMFCS II and did not require assistive devices except for long-distance 

settings. The children were community ambulators and had ranges of experience with assistive 

devices. The children were asked to walk over the short distance of the testing area without the 

aid of an assistive device. Four children with a GMFCS III used crutches to walk for the baseline 

trials and one child used a walker for baseline trials. The data for the subject who used a walker 

in baseline trials was used for kinematic and kinetic analysis for walker-assisted trials only. 

Statistical analyses were performed assuming unequal variances with this additional subject. 

Subject assent and parental consent were approved by the University of Virginia’s Human 

Investigation Committee and were obtained for all subjects. 

A full body marker set of 38 kinematic markers following the Plug-in-Gait marker set 

was attached to all subjects. Subjects walked along a straight path for 15 meters at their self-
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selected comfortable walking speed. Three-dimensional kinematic data were collected using a 

12-camera Vicon Nexus Motion Capture System (Oxford Metrics, UK) sampling at 100Hz. 

Ground reaction forces were collected with five Bertec force plates sampling at 1000Hz. The 

force plates were embedded in the floor in the center of the path for each trial. For trials with the 

instrumented posterior walker, three-dimensional handle reaction forces were collected with 6-

DOF ATI load cells sampling at 1000Hz. The load cells were connected in line between the 

walker and handle grips (Figure 4.1). Each subject completed a minimum of three trials for each 

walking condition where two sequential steps were labelled for events of foot strike and foot off. 

The first condition for walking was a baseline, where the subject walked without any device aid 

other than their AFO’s if prescribed or with crutches as necessary. For the second condition the 

children were instructed to walk with a pediatric posterior walker. The data collected in Vicon 

was processed with the Nexus program where a total of 7 gait cycle events were labelled: foot 

strike, contralateral toe off, contralateral foot strike, toe off, foot strike, contralateral toe off, and 

contralateral foot strike. Events were labelled using recorded force plate data over the trial. Foot 

strike occurred when the vertical force on the respective plate was greater than a 15 N threshold. 

Toe off was marked when the vertical force fell below the 15 N threshold. 
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Figure 4.1: Instrumented posterior walker with 6 DoF load cells attached between handles and 

frame of walker.  
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4.2.2 Preparation for Modelling 

Kinematic and kinetic data were exported from Nexus for processing in Matlab before 

the trials were modelled. Along with stored values for the subjects’ anthropometric data the 

kinematic data for the body was written to a file for MSC.ADAMS to read. Force and moment 

data from the force plates and load cells was filtered using a lowpass, Butterworth filter with a 

cutoff frequency at 100Hz. Kinematic marker positions were filtered using a lowpass, 

Butterworth filter with a cutoff frequency of 15Hz. The global coordinate system (ǔ) in Vicon 

had the X axis aligned with the direction of travel, the Y axis normal to the sagittal plane, and the 

Z axis positive in the vertical direction. The model was created in a global coordinate system (ũ) 

where the X axis was aligned with the direction of travel, the Y axis was positive in the vertical 

direction, and the Z axis was normal to the sagittal plane. The coordinate system for the model is 

defined from the Vicon global reference frame by a 90-degree rotation about the positive X axis. 

𝑅 =  [
1 0 0
0 0 1
0 −1 0

]  ũ =  Rǔ 

 

4.2.3 Physical Model 

A scaled model was created for each subject in MSC.Adams with the LifeMod plugin 

using subject-specific anthropometric data (age, height, mass, and gender). The model (Figure 

4.2) consisted of 19 rigid body segments: head, neck, upper torso, central torso, lower torso, 

clavicle (2), upper arms (2), lower arms (2), hands (2), upper legs (2), lower legs (2), and feet 

(2). The physical properties of the body’s segments were defined using the Generator of Body 

Data (GeBOD) database (Cheng, Obergefell, & Rizer, 1994). Center of mass was calculated 

from the segment’s positions. 18 joints were defined between segments and allowed triaxial 
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rotation except for the wrist and elbow which allowed two axes of rotation and the knee which 

allowed one. An additional joint in the upper neck existed in the model but was locked and so 

was not considered in the analysis. 
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Figure 4.2: Rigid body model segments imported and scaled from GeBOD database with 

joints (blue spheres) and center of mass (red sphere). 
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For each subject a static trial was used to scale the body from the GeBOD database using 

age, weight, height, and gender as defining parameters. Three trials for each walking condition 

were modelled for kinematic and kinetic analysis of the body over the gait cycle. The motion of 

the body was driven by the kinematic markers attached to the model by spring-damper systems. 

Dynamic optimization of the springs to maintain minimum residual spring energy were used in 

inverse kinematic analysis to drive the motion of the body and joint kinematics were recorded. 

Recorded joint motion was used as input for PD controllers on the joints of the body during 

dynamic simulations. Integral components were not included in the controllers because there is 

no steady-state period for which they are most useful. An integral component would act to 

destabilize the model because kinetics in gait are periodic and dynamic. For the dynamic 

simulations, other necessary forces were added to the model along with fixed-position blocks 

signifying the floor and embedded force plates. Gravity was generally applied to the whole body. 

Ground reaction forces from force plates embedded in the floor had varying centers of pressure 

and multiple methods were considered to increase accuracy and simplicity for the model. Ground 

reaction forces were applied as contact forces from the center of the respective force plates to the 

center of mass of the respective foot. Moments were also applied which acted to correct the 

moment arm in the force application to the ankle. This method was found to be accurate for force 

application as three-dimensional ankle, knee, and hip moments were correctly applied in the PD 

controller. Ground reaction force was trimmed to include force plate data from the identified gait 

cycles within the trial. One gait cycle was considered a left foot heel strike to left foot heel strike 

and vice versa in the right foot. Twenty frames were included on either side of the gait cycles to 

avoid modelling error during the time period of interest. This placed time periods of 
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instantaneous force application from the force plates outside of the gait cycle for the later 

analysis to not include impulse controlling moments in the joints.  

The model analyzed joint kinematics and kinetics at discrete time points where kinematic 

motion drove the motion and the force application to the body was also discrete. The reaction 

forces could thus be applied at times off by one hundredth of a second and this would cause 

discrete error between the body and force application time. To account for this discrete error a 

spring-damper control on rotational and translational motion of the body center of mass was 

created to lock the center of mass motion to follow the recorded motion from the inverse 

kinematic simulation. The center of mass control applied the minimum force needed to correct 

the body for discrete error inherent to dynamic simulations. For all trials, joint kinematics and 

kinetics and center of mass movement were exported from dynamic simulations with the body, 

ground reaction forces, and gravity as inputs.  

For trials with the instrumented walker a model was created to include the handle 

reaction forces. The creation of the walker model is detailed in Appendix 1 (Figure 4.3). The 

walker motion was driven by spring-dampers applied from the locations of the kinematic 

markers defined on the walker and each trial’s kinematic data. A contact force between the 

walker handles and the center of mass of the hand was created for the application of the force 

from the load cells. The reference marker used for this force was aligned with the origin of the 

load cell. Joint kinematics and kinetics and center of mass motion were exported as model 

outputs from the dynamic simulations for walker trials.  
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Figure 4.3: Sample frame from dynamic model simulation of walker-assisted gait. Red arrows 

indicate contact forces applied to the body.  
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4.2.4 Kinematics and Kinetics 

Joint kinematics and kinetics were output from the model for the whole gait cycle. The 

model outputs for joint angles were used to quantify posture by looking at the knee, hip, and 

trunk angles along with the pelvis segment orientation. The traditional method to examine 

posture uses four time points of the gait cycle to represent a range of angles through the gait 

cycle: initial heel strike, midstance, pre-swing, and mid-swing (Logan, Byers‐Hinkley, et al., 

1990). Midstance and mid-swing times were defined as half the time between heel strike and toe 

off and vice versa (Gibson, Jeffery, & Bakheit, 2006). The novel method for examining the 

kinematics and kinetics of walker use utilized statistical parametric mapping to measure the 

significance of changes in the knee, hip, and trunk over the whole gait cycle. A better posture 

would be seen by a more upright position of the three joints and a lower variance in angles in the 

trunk. TD and CP group baseline gait was compared to observe the pathology of the CP group. 

To avoid confounding statistical variables four subjects from the CP group were used as they did 

not require crutches or other assistance during their baseline gait. 

Joint kinematics and kinetics over the gait cycle were compared between baseline and 

walker-assisted gait for the TD group and the CP group. The group of CP subjects who used 

crutches was compared in their baseline and walker-assisted gait to the gait of the unassisted 

group during their walker-assisted gait. The effect of the walker on model outputs provided 

potential reasons for the spatiotemporal differences noted in Chapter 3. It was important to keep 

these changes in mind as the model outputs were examined over single gait cycles that were 

normalized by stride time. Since velocity was lower in walker-assisted trials, some of the model 

outputs were expected to reach lower peaks over the gait cycle (Schwartz et al., 2008). 
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4.2.5 Statistical Parametric Mapping 

Baseline and walker trial outputs were compared using one-dimensional statistical 

parametric mapping (SPM) originally designed for neurological testing (Friston et al., 2011). 

SPM has been shown to be a valuable statistical test for biomechanical comparisons by Pataky in 

a series of studies and SPM1D software interface in Python and Matlab (Pataky, 2010, 2012). 

SPM analysis performs better over time periods than individual tests of each point because it 

considers the surrounding data points in calculating the p-value in post hoc analysis (Pataky et 

al., 2016). SPM allowed for the comparison of joint kinematics and kinetics over the gait cycle 

and identified time periods where walker-assisted gait deviated from baseline gait. 

 

4.3 Results 

4.3.1 Subjects 

Subject anthropometrics were recorded during collection and are presented in Table 4.1. 

Body Mass Index was calculated based on subject mass, height, and age. Two groups were 

created to compare outcomes, one group of children with a diagnosis of cerebral palsy (CP) and 

another of typically developed (TD) peers as a control group. A range of children and young 

adults participated in the study for both groups. Through t-test comparison, weight (p=0.019) and 

height (p=0.049) were different between the groups. This highlights the differences between the 

populations, but for the purposes of this work the populations were considered similar as 

significance was not found in age or body mass index (BMI). 
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Table 4.1: Subject Anthropometrics. Significance between TD and CP groups is marked as 

* (p<.05), ** (p<0.01), *** (p<0.001). 

Group Age (years) Weight (kg) Height (cm) BMI 

TD 16±5.4 57.4±20.4 160.6±19.7 21.2±4.8 

CP 13.5±2.4 36.2±5.6 * 144.0±6.6 * 17.2±2.1 
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4.3.2 Walker Effect on Posture 

The effect of the walker on the posture of the user was quantified by calculating the knee, 

hip, and trunk angles at four time points for baseline and walker trials (Table 4.2). The pelvis 

flexion angles are defined by a negative value indicating a forward rotation. The model’s neutral 

pelvic angle was not equivalent to anatomical neutral. Static orientation of the model made the 

lumbar takeoff angle -18 degrees. For the CP group, greater negative values resulted because the 

model did not account for pelvic tilt of the subject. The effect of this is carried over into the 

lumbar joint by subtracting from the flexion angle. Statistical comparisons between baseline and 

walker trials aided in defining the difference between a child with CP walking with and without a 

walker. For the CP group, lumbar extension was greater at mid-stance and mid-swing between 

baseline and walker trials (p<0.05). The CP group had an inherent pelvic tilt quantified by the 

difference between the pelvis segment angle and the lumbar. The pelvic flexion angle was more 

neutral in the walker-assisted trials for the children with CP. Upper torso posture was better in 

the TD group with a walker as thoracic joint flexion was lower and more neutral. 
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Table 4.2: Flexion angles for the pelvis segment and thoracic, lumbar, hip, and knee joints at 

four significant time points of gait cycle. Presented as average ± standard deviation. T-test 

significance for p<0.05 (*), p<0.01 (**), and p<0.001 (***). 

Pelvis 
Trial 

Type 

Initial 

Contact 
Mid-Stance Pre-Swing Mid-Swing 

     TD 
Baseline -14.98±2.31 -15.62±2.24 -15.36±2.71 -15.51±2.10 

Walker -13.96±2.87 -15.28±2.98 -14.92±3.27 -15.57±2.93 

     CP 
Baseline -17.15±4.62 -13.72±4.37 -13.70±4.08 -13.41±5.25 

Walker -14.05±1.31 -9.74±0.55 -9.38±3.82 -9.63±1.07 

Thoracic      

     TD 
Baseline 1.90±3.67 4.71±3.75 4.71±3.56 5.17±3.71 

Walker -2.63±4.18* -1.17±4.25** -0.97±4.52** -0.90±4.17** 

     CP 
Baseline 6.35±8.84 12.62±7.59 13.95±9.82 12.57±6.38 

Walker 6.54±11.50 11.58±12.35 9.75±13.34 10.88±11.86 

Lumbar      

     TD 
Baseline -18.48±2.57 -20.25±2.71 -19.55±3.26 -20.49±2.62 

Walker -17.70±3.06 -19.84±3.73 -18.50±4.46 -20.09±4.21 

     CP 
Baseline -28.29±3.57 -26.71±2.85 -27.71±3.30 -26.60±2.93 

Walker -32.56±2.88 -32.22±2.60* -31.54±3.03 -32.61±2.68* 

Hip      

     TD 
Baseline 35.06±3.61 8.66±3.68 0.50±6.26 35.64±3.74 

Walker 33.41±5.18 8.44±6.30 3.60±7.11 34.68±2.99 

     CP 
Baseline 40.40±5.37 14.75±14.43 3.38±11.10 31.03±6.02 

Walker 37.85±5.42 19.88±8.71 4.09±7.41 28.92±8.96 

Knee      

     TD 
Baseline 4.90±2.01 7.28±2.48 37.87±5.40 52.43±6.75 

Walker 3.04±2.59 6.07±4.01 38.66±6.18 50.07±5.48 

     CP 
Baseline 29.03±5.89 19.17±15.75 41.18±9.04 54.54±5.45 

Walker 29.06±6.29 15.42±17.00 31.38±11.00 49.02±10.19 
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4.3.3 Model Outputs 

Dynamic models were successfully created for three trials of each condition of walking 

for each subject. The model outputs included joint angles and moments for the defined joints of 

the model. TD and CP group baseline gait was compared initially to examine the difference in 

gait between the groups (Figures 4.4-4.6). Four subjects comprised the CP group as the rest of 

the group used crutches or a walker during baseline gait and would have been a confounding 

variable in the gait of the whole group. Within group differences were marked with shaded boxes 

on the figures where the walker trials were significantly different than the baseline. Pelvic 

segment tilt, obliquity, and rotation angles were included to show the inherent neutral angle of 

the model, as it was not equivalent to anatomical neutral. Pelvic tilt angles were offset from 

neutral by values between -10 and -18 degrees, while obliquity and rotation angles fluctuated 

around 0 degrees. 

 

4.3.3.1 TD Group vs CP Group Baseline Gait 

In the lower body, the CP group had a lower range of motion and increased loads on the 

joints over their baseline gait than the TD group highlighting the pathology of their gait (Figure 

4.4). Based on gait kinematics, the CP group walked with crouch gait and reciprocal effects on 

joint kinetics were observed. The ankle was in sustained dorsiflexion and reduced internal 

rotation and inversion early in swing phase. The knee was in flexion throughout the gait cycle 

and never reached an extended, zero-degree, angle. The hip had greater flexion in CP gait and 

more internal rotation. Ankle plantarflexion moment was characteristic of a lack of heel strike as 

the observed initial peak of load bearing did not occur in the TD group. Knee extension moment 

was greater in late stance phase and hip extension moment was greater through stance phase. 
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In the upper body, CP gait was characterized by worse posture than TD gait (Figure 4.5). 

Pelvic flexion offset was around 15 degrees on average through the gait cycle for both TD and 

CP groups. The CP group had greater extension in the lumbar joint and greater range of motion 

and peak flexion in the thoracic joint. The TD group laterally rotated in the lumbar joint towards 

the stance foot with two peaks during stance phase of both feet. The CP group had a reduced 

second peak in the lumbar during terminal stance and terminal swing phase of the gait cycle. The 

CP group axially rotated less than the TD group in the lumbar joint with lower peaks around heel 

strike. The CP group had a greater range of lateral motion in the thoracic joint than the TD group 

with cyclical peaks characterizing bending towards the stance foot. Axial rotation of the thoracic 

joint was delayed in the CP group around contralateral and ipsilateral mid-swing compared to the 

TD group. The lumbar flexion moment was greater in CP gait but not significant. The lateral 

trunk moments of both lumbar and thoracic joints were greater in the CP group than the TD 

group around mid-stance and early swing. Axial rotational moment in the lumbar was opposite in 

sign in the CP group compared to the TD group around toe off times. Shoulder flexion was 

decreased in CP gait characterizing an overall lower range of motion in the arms by the CP group 

(Figure 4.6). Children with CP held their arms up to the side and out in front of them particularly 

during mid-stance.  
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Figure 4.4: Lower body kinematics (left) and kinetics (right) for TD group (black) compared to CP group (blue). SPM significance 

highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

*** ** * ** *** *** *** *** *** *** *** 

*** ** ** *** 

* * * *** * * *** *** *** *** *** 
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Figure 4.5: Trunk kinematics (left) and kinetics (right) and pelvic segment kinematics (bottom) for TD group (black) compared to CP 

group (blue). SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***). Flexion 

was characterized by bending forwards and extension by bending backwards from the reference frame on the pelvis. Positive lateral 

bending and axial rotation was in the direction of rotation towards the stance foot. Pelvic tilt is negative for forward rotation, obliquity 

is positive for rotation away from stance foot rotation is positive for vertical-axis rotation away from stance foot.   

*** * * * * *** ** *** 
*** 

*** *** *** 

*** *** *** * * ** *** *** *** *** 

* * 

* 

** * 

** 
*** ** 
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Figure 4.6: Upper body kinematics (left) and kinetics (right) for TD group (black) compared to CP group (blue). SPM significance 

highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

* * * *** *** *** 

*** *** *** *** 
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4.3.3.2 TD Group Baseline vs Walker-Assisted Gait 

Baseline and walker trial model outputs were compared using one-dimensional statistical 

parametric mapping (SPM) analysis. In the TD group, ankle kinematics and kinetics were no 

different in walker-assisted gait compared to baseline (Figure 4.7). Peak knee flexion was lower 

during initial loading and a reciprocal decrease in extension moment occurred in walker-assisted 

gait. The TD group also had lower abduction angles in the hip around toe off and heel strike 

times of walker-assisted gait. In walker-assisted gait the TD group had lower flexion angles in 

the thoracic joint and a greater flexion moment during swing phases of gait for the lumbar and 

thoracic joints (Figure 4.8). Axial rotation range of motion was decreased in the lumbar and 

thoracic joints during late stance phase and toe off. Axial rotational moment was decreased in 

lumbar and thoracic joints during peaks near toe off. Walker interaction during gait caused 

shoulder extension throughout TD gait and greater elbow flexion compared to baseline (Figure 

4.9). Shoulder flexion moment was lower in walker-assisted gait during late swing phase 

approaching heel strike.  
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Figure 4.7: Lower body joint kinematics (left) and kinetics (right) for the TD group baseline gait (black) compared to walker-assisted 

gait (blue). SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

** * 

*** *** 
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Figure 4.8: Trunk kinematics (left) and kinetics (right) and pelvic segment kinematics (bottom) for TD group baseline gait (black) 

compared to walker-assisted gait (blue).  SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), 

and p<0.001 (***). Flexion was characterized by bending forwards and extension by bending backwards based off of pelvic tilt. 

Positive lateral bending and axial rotation was in the direction of rotation towards the stance foot. Pelvic tilt is negative for forward 

rotation, obliquity is positive for rotation away from stance foot rotation is positive for vertical-axis rotation away from stance foot.  

* *** * *** *** *** *** *** 

*** * *** *** *** *** *** 

* * * 
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Figure 4.9: Upper body kinematics (left) and kinetics (right) for TD group baseline gait (black) compared to walker-assisted gait 

(blue). SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***). 

  

** * *** 

*** * 
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4.3.3.3 CP Group Baseline vs Walker-Assisted Gait 

In the CP group, posture was better and a decreased load on the lower body was observed 

(Figure 4.10). The knee was more extended particularly during swing phase and early in stance. Lower 

extension moments during initial loading occurred in the hip, knee, and ankle. Lumbar extension angles 

were greater in walker assisted gait throughout the gait cycle (Figure 4.11). Thoracic lateral bending was 

decreased over the gait cycle in walker-assisted gait compared to baseline gait during single support 

times. Decreased lateral bending moments in the thoracic and lumbar joints near toe off occurred in 

walker-assisted gait. Shoulder abduction angle in early stance phase was minimized in walker-assisted 

trials, the CP group typically adducted their shoulders throughout the gait cycle (Figure 4.12). 

Additionally, the CP group had a greater shoulder adduction moment throughout the gait cycle which 

was significant during swing phase. Shoulder extension moment was increased in early stance phase. 

Elbow flexion was decreased in late stance and throughout swing in walker assisted gait. Extension 

moment in the elbow was greater in walker assisted gait throughout the gait cycle and pronation moment 

was greater around the time of heel strikes.
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Figure 4.10: Lower body joint kinematics (left) and kinetics (right) for the CP group baseline gait (black) compared to walker-assisted 

gait (blue). SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

* 
** 

* * *** * 

*** 
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Figure 4.11: Trunk kinematics (left) and kinetics (right) and pelvic segment kinematics (bottom) for CP group baseline gait (black) 

compared to walker-assisted gait (blue). SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), 

and p<0.001 (***). Flexion was characterized by bending forwards and extension by bending backwards based off of pelvic tilt. 

Positive lateral bending and axial rotation was in the direction of rotation towards the stance foot. Pelvic tilt is negative for forward 

rotation, obliquity is positive for rotation away from stance foot rotation is positive for vertical-axis rotation away from stance foot.  

*** *** ** 

** ** *** 

*** *** 
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Figure 4.12: Upper body kinematics (left) and kinetics (right) for CP group baseline gait (black) compared to walker-assisted gait 

(blue). SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

* ** * *** 

** *** *** ** 
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4.3.3.4 CP Group vs CP Crutch-User Gait 

The CP group which walked without assistive devices (NA) in their baseline trial was 

compared to the CP group who used crutches (CA) during baseline trials. The manual walker 

trials for the NA group (black) were compared to the baseline (blue) and manual walker (red) 

trials for the CA group using SPM (Figures 4.13-4.15). Kinematics for all trials were considered 

but kinetics for baseline, crutch-assisted trials were not included as the crutches were not 

instrumented like the walker. The CA group walked with increased pathologic gait in the ankle 

joint during baseline, crutch-assisted gait (Figure 4.13). Increased dorsiflexion, inversion and 

internal rotation of the ankle characterized the CA group in crutch- and walker-assisted trials. 

Increased plantarflexion and inversion moment occurred in CA group compared to NA group 

walker-assisted trials. Hip and knee flexion were similar to the NA group but hip adduction was 

decreased in the CA group at mid-stance and internal rotation was lower through the gait cycle 

compared to walker-assisted gait of the NA group. Hip extension moment was greater in the CA 

group at contralateral toe off than the NA group. 

The CA group was less stable in the torso in crutch-assisted gait compared to the NA 

group (Figure 4.14). Decreased extension in the lumbar and extension in the thoracic joint were 

observed in the baseline gait of the CA group compared to walker-assisted gait in the NA group. 

In walker-assisted gait, the CA group had increased extension in the lumbar joint similar to eh 

NA group. The CA group walked with greater peak lateral bending in crutch-assisted gait and 

had decreased lateral bending in walker-assisted gait. The CA group had greater flexion 

moments in the lumbar and thoracic joints throughout the gait cycle compared to the NA group. 

The CA group showed a different pattern of usage of assistive devices than the NA group 

based on upper body kinematics (Figure 4.15). Elbow flexion was increased in CA group crutch- 
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and walker-assisted trials. Elbow pronation was greater in crutch-assisted gait but the same in 

walker-assisted gait as the NA group. The shoulder was extended near heel strike for CA group 

crutch-assisted trials and for the entire gait cycle during walker-assisted trials. Shoulder 

adduction was increased in the CA group in early swing for both crutch- and walker-assisted 

gait. In walker-assisted gait, the CA group had increased, cyclic flexion moment in the shoulder 

and extension moment in the elbow compared to the NA group. Peak moment occurred at 

contralateral and ipsilateral heel strike times and troughs occurred around mid-stance.  
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Figure 4.13: Lower body joint kinematics (left) and kinetics (right) for manual walker gait in the NA group (black) compared to 

crutch-assisted gait in the CA group (blue) and walker-assisted gait in the CA group (red) with significance from SPM analysis 

marked with shaded boxes in respective colors and with p<0.05 (*), p<0.01 (**), and p<0.001 (***) for crutch-assisted gait (top) and 

walker-assisted gait (bottom).  

* *** * 

*** * 

* 

* *** 

*** 
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Figure 4.14: Trunk joint kinematics (left) and kinetics (right) and pelvic segment kinematics (bottom) for manual walker gait in the 

NA group (black) compared to crutch-assisted gait in the CA group (blue) and walker-assisted gait in the CA group (red) with 

significance from SPM analysis marked with shaded boxes in respective colors and with p<0.05 (*), p<0.01 (**), and p<0.001 (***) 

for crutch-assisted gait (top) and walker-assisted gait (bottom). Flexion was characterized by bending forwards and extension by 

bending backwards based off of pelvic tilt. Positive lateral bending and axial rotation was in the direction of rotation towards the 

stance foot. Pelvic tilt is negative for forward rotation, obliquity is positive for rotation away from stance foot rotation is positive for 

vertical-axis rotation away from stance foot.  

*** * 

*** 

*** 

**

 

* * * 

* 

* ** 
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Figure 4.15: Upper body joint kinematics (left) and kinetics (right) for manual walker gait in the NA group (black) compared to 

crutch-assisted gait in the CA group (blue) and walker-assisted gait in the CA group (red) with significance from SPM analysis 

marked with shaded boxes in respective colors and with p<0.05 (*), p<0.01 (**), and p<0.001 (***) for crutch-assisted gait (top) and 

walker-assisted gait (bottom). Kinetics of the shoulder and elbow are on larger scales than other group plots.  

* 

*** 

*** 
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4.4 Discussion 

The dynamic model created for baseline and walker trials provided additional data for 

secondary analysis. Further evidence of the pathologic gait of CP was found by comparing the 

kinematics and kinetics of baseline gait of the TD and CP groups. The model outputs for 

kinematics and kinetics revealed more about the impact of the posterior walker on the gait of the 

user. TD and CP groups interacted with the walker in different ways and the lower body 

outcomes agreed with the assumption that the groups would alter their gait to incorporate the 

posterior walker. The posterior walker limited the TD group motion in the knee during initial 

loading and the thoracic joint posture was more vertical. The posterior walker reduced the load 

on the lower body joints in the CP group during early stance phase. The CP group was more 

stable in walker assisted gait when comparing to baseline unassisted and crutch-assisted gait as 

lateral motion and moment in the torso was reduced. In Chapter 3, positive effects of the 

posterior walker were only seen in the GMFCS III group but better posture and reduced load in 

the lower body are seen in the whole CP group when walking with a walker. So far, the utility of 

a posterior walker has been dependent upon what metric was used as the factor for analysis but 

the model kinematics and kinetics offer a more complete analysis of the walker-assisted gait 

cycle. 

The joint kinematics for the CP group had a lower range of motion than in the TD group. 

Previous work has shown a decreased range of motion in the ankle, knee, and hip joints for 

children with CP (Krautwurst et al., 2016a). This was particularly characterized by less extension 

in the hip around 40-55% of the gait cycle, more flexion in the knee throughout the gait cycle, 

and less plantarflexion in the ankle around toe off. In this work, the ankle angles typically did not 

vary outside of the 0- to 20-degree range and remained relatively constant through the gait cycle 
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quantifying a lower engagement of the ankle joint through plantarflexion motion. The lack of 

ankle movement was caused by the prescribed ankle foot orthoses worn by the children with CP. 

The CP group walked in slight dorsiflexion and engaged a plantarflexion moment throughout 

their stance phase representing a slight toe-walking gait. The knees and hips spent more time in 

flexion than the typical gait which is characteristic of apparent equinus and crouch gait (Armand 

et al., 2016a). The CP group was less stable than the TD group because CP lumbar and thoracic 

joints were aligned at worse postures in the sagittal plane and the lumbar joint had a lower range 

of motion in the frontal and transverse planes. The thoracic joint in the CP group had a greater 

range of motion in lateral bending than the TD group which indicated a use of the upper torso for 

control of stability in addition to the lower torso. Higher moment in the torso highlighted the 

need for support in their gait as in baseline trials the CP group required more moment generation 

about their torso to walk and maintain their posture. Shoulder and elbow range of motion was 

lower in the TD group while moment was higher. The CP group moved their upper body less 

than the TD group in baseline trials but required greater joint moments to remain stable in their 

gait. Further analysis on stability of gait should be done examining the angular momentum of the 

body segments to quantify whole-body stability during gait. The incorporation of a posterior 

walker was expected to increase the stability and promote better posture of the user. 

Within the TD group, the addition of the walker lowered the peak flexion angle of the 

knee during stance phase, which was not confirmed by the traditional individual time point 

analysis. These results are indicative of the walker limiting the range of motion of the TD group. 

The walker lowered the mechanical load on the knee by lowering the peak extension moment in 

stance phase. This occurred while also decreasing the flexion range of motion at this time period 

in the knee. The TD group had lower range of motion in axial rotation of the lumbar and thoracic 
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joints which is one factor contributing to the lower stride length in walker-assisted gait found in 

Chapter 3 (S. D. Russell, Bennett, Kerrigan, & Abel, 2007). Posterior walkers have been shown 

to positively affect posture in children with CP (Logan, Byers-Hinkley, et al., 1990), and TD 

group posture was altered as well. The thoracic joint flexion angle was lower throughout the gait 

cycle, operating at a more neutral position and a lower angular displacement on average. Lumbar 

and thoracic moments were greater in flexion and lower in axial rotation. The load of the walker 

was taken on by activation in the torso for the TD group while through the rest of the body other 

moments and kinematics were lowered. The lumbar and thoracic joint flexion moments were 

greater during both ipsilateral and contralateral single support times. As expected the shoulder 

and elbow joints had a lower range of motion as the arms were interacting with the walker and 

remained relatively constant through the gait cycle. The shoulder joint moment was lower during 

swing phase. In baseline trials the flexion moment of the shoulder was in preparation for the 

swing of the shoulder during stance phase, but in the walker trials the shoulder joint range of 

motion was lower. 

The CP group saw greater lumbar extension at mid-swing and mid-stance in walker-

assisted gait. SPM analysis also found the lumbar to be more extended during walker-assisted 

gait. The CP group was largely characterized by an anterior pelvic tilt so the increase in trunk 

extension angle resulted in a more upright position for the user. Posterior walkers have been 

shown to be most effective in increasing posture for children with CP (Brooke M. Greiner et al., 

1993). On average, the walker affected the upright position and the stability of the user positively 

in the CP group. The CP group had reduced lateral bending in the thoracic joint and slightly less 

range of motion in the shoulder and elbow when walking with the walker. There was a large 

standard deviation in this group, so it is likely that more data and a refined subject group would 
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increase the power of the findings presented and potentially reveal more about the population. 

For the CP group, flexion moment for hip, knee and ankle joints in the walker trials typically 

reached lower magnitude at the local maxima in mid-stance. Similar to the TD group, the walker 

decreased the load on the lower body joints particularly in stance phase but to a greater degree in 

the CP group. This is due to the CP group relying more on the walker as a population than the 

TD group. Elbow flexion angle was lower from mid-stance through swing phase. The CP group 

walked with their elbows highly flexed in baseline trials, walking with the walker necessitated 

the extension of the elbows to hold on to the walker for support and to pull the walker along. 

Children with CP used the walker for support during gait and the shoulder and elbow seem to be 

the primary loading joints for this support. Increased upper body load occurred alongside lower 

body joint load reductions which could allow children with CP to walk for longer periods 

throughout the day. The increased adduction moment of the shoulder in the walker trials show 

the reliance on and functional use of the walker by the CP group. Increased extension moment in 

the elbow highlights the vertical force being applied to the walker. The greatest elbow extension 

moment occurred after heel strike during double support. Cyclical loading revealed the CP group 

relying on the walker progressively more through swing reaching a maximum during double 

support after heel strike and a decrease in reliance during double support. While the TD group 

absorbed the walker’s load through flexion moment in the torso joints, the CP group did not. By 

sharing the load of support during their gait cycle over four limbs, children with CP were able to 

walk better than in baseline trials. With a posterior walker, users are able to walk longer during 

the day train their muscles more to avoid atrophy as they grow. The CP group bore the weight of 

pulling the walker in the shoulder and elbow joints while also relying more heavily on the walker 

for support through their gait. 
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The CA engaged with the walker more than the NA group and had greater positive 

effects on posture by using the walker than while using their prescribed crutches. Lower body 

kinematics remained relatively unchanged from baseline to walker-assisted gait in the CA group. 

Compared to the NA group, the CA group displayed increased pathology in the lower body 

through greater ankle dorsiflexion throughout the gait cycle. The CA group had increased 

posture when walking with the walker as the lumbar was more extended to a similar value of the 

NA group. Lateral bending in the thoracic joint was decreased when walking with the walker as 

well compared to walking with crutches. Compared to the NA group, the CA group relied on the 

walker more for assistance. Lower body kinetics were similar except hip extension moment was 

greater in early stance and ankle moments were greater during stance phase. Flexion moments 

were greater over the whole gait cycle in CA walker-assisted gait compared to the NA group and 

shoulder and elbow joint kinetics were greater and more cyclic in usage in the CA group. Peak 

upper body loads occurred after heel strike and torso loads peaked following toe off. The 

increased usage of the walker by the CA group was expected as the group was not able to walk 

without assistance and thus were more affected by CP. 

 

4.5 Conclusions 

The dynamic model performed adequately to give accurate results for joint kinematics 

and kinetics. The positive impact of a posterior walker on gait was observed in both groups. In 

walker-assisted gait, both groups experienced decreased lower body load early in stance phase. 

The inclusion of the walker in the model saw a more upright positioning of the torso in the CP 

group indicating a more stable positioning of the body. The TD and CP group incorporated the 

walker into their gait in different ways. While decreasing knee moment, the TD group pulled the 
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walker along through torso flexion and axial moment. The CP group pulled the walker along and 

loaded the walker for support through increased moments in the arms. The mechanical work of 

the body will be investigated in Chapter 5 to observe the effect of the walker on energetic cost on 

joints and the whole body.  
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Posterior Walker-Assisted Gait in Children With and Without 

Cerebral Palsy: Mechanical Work 

5.1 Introduction 

It is generally believed that typically developing children walk with a cyclic gait pattern 

which employs movement methods that are the most energetically efficient to achieve the 

desired motion (Cavagna, Thys, Zamboni, Vagna, & Thiys, 1976). Bipedal walking is 

comparable to a simple pendulum system where the tradeoff between potential and kinetic 

energy drives the system. Decreases in energetic efficiency occur in bipedal walking through 

muscle actuation to overcome energy loss and to maintain stability of the system. Cerebral Palsy 

(CP) is a non-progressive motor development disorder initiated by a lesion to the brain around 

the time of birth. CP can inhibit the growth, neurological control, and function of ambulatory 

muscles often causing different visual gait patterns depending on how it manifests itself in the 

patient. For persons with CP, gait efficiency can be significantly lower than their typically 

developed peers due to excess motion used for balance and co-contraction of muscles (Ries & 

Schwartz, 2018; S. Russell et al., 2011a). This excess energy cost is important for clinicians to 

keep in mind as they consider interventions to assist with gait. While CP is non-progressive, 

children with CP are observed as they grow because the effectiveness of their musculoskeletal 

structure in gait may decline as they age (Damiano, 2006; Hanna et al., 2009; Richards & 

Malouin, 2013). This can cause further motor impairment and make ambulation more inefficient 

if not impossible and force the young adult into a wheelchair. Clinical intervention often includes 

the prescription of the use of an assistive device which acts to stabilize the user during walking, 

like a posterior walker. This work theorized that the posterior walker would add an energetic cost 

associated with pulling it along and increase the energy requirements of the users’ gait. The 
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energetics of walker-assisted gait have not been examined in this way to define the cost of the 

walker in previous literature. 

Many studies have shown that the gait of children with CP requires more energy use 

compared to their typically developed peers through oxygen consumption and heart rate 

measures (Norman et al., 2004; Unnithan et al., 1996). Studies have also shown that as children 

with CP age, their energy use during gait increases (Bolster, Balemans, Brehm, Buizer, & 

Dallmeijer, 2017b). These methods of measuring energy cost on the individual cannot correlate 

an increase in energy cost to a specific time in the gait cycle or part of the body as they are 

calculated for the whole body over long periods of activity. Mechanical energy metrics can be 

applied to the whole body while still providing individual time points of data for different 

segments and joints of the body. In pediatric CP gait mechanical work is higher than in the gait 

of their typically developed peers (Van de Walle et al., 2012; van den Hecke et al., 2007). For 

mechanical energy outcomes to be accurate they must incorporate the entire body for analysis 

otherwise the minimum energetic cost would be biased by the excluded segments.  

The energetic cost of using an assistive device for a child with CP has not been 

adequately addressed in literature. Previous work examining walker use made mechanical energy 

calculations for upper body segments and has not looked at the whole body. One study by Konop 

et al. (Konop et al., 2009) looked at upper body kinetics during walker use. They found 

preliminary data suggesting a relationship between heart rate and the force used to move the 

walker forward. Other studies have only looked at the kinematics of the gait and did not 

instrument the device to model kinetics (Krautwurst, Dreher, & Wolf, 2016b; Paul et al., 2007; 

Protas et al., 2007). This work computed the load of the walker in pediatric gait by measuring the 

forces applied to the walker and calculating mechanical joint work over the gait cycle. Lower 
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body, torso, and upper body segment work were calculated to examine the effect of walker-

assisted gait on different joints in the body. It was hypothesized that the total mechanical work 

for baseline gait would show similar trends as previously published metabolic data comparing 

CP and TD groups. Additionally, the incorporation of the walker into a dynamic model was 

expected to increase the accuracy of the model outcomes for walker-assisted gait and reveal the 

dynamic cost of the walker on gait. By pulling the walker along, the CP group was expected to 

spend more energy in walker-assisted gait than baseline for the benefit of using the walker for 

support. 

 

5.2 Methods 

5.2.1 Subjects and Model 

The kinematic and kinetic data for the same 17 children collected in the Motion Analysis 

and Motor Performance laboratory at the University of Virginia from Chapter 4 were used. Data 

exported from Vicon Nexus software was filtered and prepared in Matlab then modelled in 

MSC.Adams with the LifeMod plugin. A model with 19 segments and 18 joints was created for 

each subject based on individual anthropometric data. Trials for baseline walking and walking 

with a posterior pediatric walker were modelled. Inverse dynamic simulations were performed 

and joint kinematics and kinetics were exported as model outputs. Individual outputs from 

baseline and walker trials were exported for analysis. 

 

5.2.2 Walker Interaction 

The forces on the walker during a gait cycle were examined to quantify the incorporation 

of the walker into the user’s gait. Directional forces were summed over the gait cycle (gc): 
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𝐹𝑋 = ∫ 𝑓𝑥𝑔𝑐
𝑑𝑥  𝐹𝑌 = ∫ 𝑓𝑦 𝑑𝑥

𝑔𝑐
  𝐹𝑍 = ∫ 𝑓𝑧𝑔𝑐

 𝑑𝑥 

The force in the direction of travel (𝐹𝑋) indicates how much force was used to move the 

walker. Anterior force was normalized by body mass to quantify the force applied to move the 

walker by each subject. The vertical (𝐹𝑍) and lateral (𝐹𝑌) forces measure the degree to which the 

walker was used for stability. Vertical and lateral forces applied to the handles were normalized 

via body mass to quantify the stabilizing forces applied by each test subject.  

The work done on the walker was quantified to examine the energetic cost of pulling the 

walker through the subject’s gait. Work done to move the walker was calculated by multiplying 

the movement of the walker by the force applied to the load cells over each time point in the gait 

cycle (gc): 

𝑊𝑤𝑎𝑙𝑘𝑒𝑟 = ∫ |𝑓 ∗ ∆𝑑|
𝑔𝑐

 

The work on the walker was normalized by the net excursion of the subject in the 

direction of travel over the gait cycle. Negative and positive work on the walker required action 

by the user and contributed to the cost of the walker for movement. Total work was calculated as 

the absolute value of the work performed on the walker.  

 

5.2.3 Total Mechanical Work 

Gait efficiency is an important outcome measure in assessing the motor function of 

children with cerebral palsy (Bolster et al., 2017b; Norman et al., 2004). Mechanical work 

estimates the energy cost on an individual by quantifying the mechanical energy cost of 

movement. Using the model outputs, the mechanical work was calculated like that presented by 

Chen et al. (Chen, Kuo, & Andriacchi, 1997). The mechanical work at the joint j is calculated as 
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the sum over the gait cycle of the product of the joint moment (𝜏𝑗) and change in joint angle 

(𝛥𝜃𝑗): 

𝑊𝑗
𝑇 = ∫|𝜏𝑗 ∗ 𝛥𝜃𝑗|

𝑔𝑐

 

Mechanical work calculates the minimum work required for the system’s movement. Co-

contraction and metabolic costs are not included, each joint’s contribution to the total cost is 

included. Individual joint totals were summed up over the gait cycle to calculate full body, lower 

body, and upper body mechanical work. 

 

5.2.4 Joint Work 

Calculating mechanical work of joints gives the ability to break the body down into 

individual segments and identify the joints with the greatest moments produced and the specific 

time points during the gait cycle where the work was greatest or least: 

𝑊𝑗 = |𝜏𝑗 ∗ 𝛥𝜃𝑗| 

The body was split up into three parts: lower body joints including ankles, knees, and 

hips; upper body joints including wrists, elbows, shoulders, and scapulae; torso joints including 

lumbar, thoracic, and neck. The work generated at these segments was examined in relation to 

the gait cycle. Both positive and negative work require muscle forces and metabolic work to 

complete the actions of the body. The absolute value of the joint work was calculated so that 

when summing up into different segments there would be no cancellation between positive and 

negative values of work for different joints. 
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5.3 Results 

5.3.1 Subjects 

Subject anthropometrics were recorded during collection and are presented in Table 5.1. 

Body Mass Index was calculated based on subject mass, height, and age. Two groups were 

created to compare outcomes, one group of children with a diagnosis of cerebral palsy (CP) and 

another of typically developed (TD) peers as a control group. A range of children and young 

adults participated in the study for both groups. Through t-test comparison, weight (p=0.019) and 

height (p=0.049) were different between the groups. This highlights the differences between the 

populations, but for the purposes of this work the populations were considered similar as 

significance was not found in age or body mass index (BMI).  
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Table 5.1: Subject Anthropometrics. Significance between TD and CP groups is marked as 

* (p<.05), ** (p<0.01), *** (p<0.001). 

Group Age (years) Weight (kg) Height (cm) BMI 

TD 16±5.4 57.4±20.4 160.6±19.7 21.2±4.8 

CP 13.5±2.4 36.2±5.6 * 144.0±6.6 * 17.2±2.1 
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5.3.2 Walker Interactions 

The average forces exerted on the walker over a gait cycle were separated into anterior, 

lateral, and vertical directions for each subject and by groups, as presented in Table 5.2. Between 

groups, significance was seen in anterior/posterior and vertical forces (p<0.001). Large standard 

deviations within the CP group lower the power of these results and point to differences in 

walker use between subjects in the CP group. The work done to move the walker was greater in 

the CP group (Table 5.3). While both TD and CP groups applied similar negative work values, 

the CP group required more positive work to pull the walker for the necessary support they 

needed during gait.  
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Table 5.2: Average forces on the walker over gait cycle in the anterior (+)/posterior (-), lateral 

(+)/medial (-), and down (+)/up (-) directions normalized by mass of subject. Significance 

between TD and CP groups marked as * (p<0.05), ** (p<0.01), *** (p<0.001). 

 
Anterior/Posterior Force 

(N) 
Medial/Lateral Force (N) Vertical Force (N) 

TD 5.933±4.198 2.026±2.587 17.45±14.27 

CP 13.31±6.716* 0.450±11.08 82.18±54.56* 

 

Table 5.3: Average total, positive, and negative work done on the walker over the gait cycle 

normalized by excursion of subject over gait cycle. Significance between TD and CP groups 

marked as * (p<0.05), ** (p<0.01), *** (p<0.001). 

 Total Work on Walker 

(J/m) 

Positive Work on Walker 

(J/m) 

Negative Work on Walker 

(J/m) 

TD 7.08±2.59 6.57±3.39 -0.51±1.09 

CP  10.62±3.77 10.18±3.85 -0.44±0.73 
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5.3.3 Total Mechanical Work 

Mechanical joint work was calculated for each joint then summed for the full body, lower 

body, upper body and torso and presented in Table 5.4. Total mechanical joint work for the 

whole body was not significantly different for the TD group when comparing the walker trials to 

the baseline trials. Reductions in knee joint work were offset by increases in shoulder, elbow, 

and wrist work. 

The CP group was comprised of four subjects who were able to ambulate without walker 

or crutch assistance in their baseline gait. The CP group had reduced total work in walker-

assisted gait compared to baseline gait which was not expected as the walker had to be pulled 

along to be used for support in their gait. The load of pulling the walker increased the upper body 

activation. The upper body joint work for the CP group was greater in the shoulder, elbow, and 

wrist in walker-assisted gait.  Large decreases in the lower body and torso joints from baseline 

gait to walker-assisted gait highlight a decreased load on the lower body and more control of the 

torso.  

Additionally, the CP group walker-assisted gait was compared to the walker-assisted gait 

of the subgroup of CP subjects who used crutches in their baseline gait. Larger variance in the 

smaller groups reduced the power of the results but the full body work was similar between the 

two groups of CP subjects. The group that walked unassisted in baseline was not as accustomed 

to using assistive devices and a larger portion of the full body work was performed by the lower 

body in walker-assisted gait. The crutch-assisted group had larger upper body work than the 

group of CP subjects who could walk without assistance in their baseline. 
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Table 5.4: Average total mechanical work for individual joints summed over a gait cycle. 

Significance between baseline and walker trials for TD group and Unassisted CP group is 

marked as * (p<0.05), ** (p<0.01), *** (p<0.001). Walker assisted trials of crutch and unassisted 

subgroup are compared and marked following the same method. 

Work 

(J/kg*m) 
TD Group CP Group 

  Unassisted subgroup 
Crutch-assisted 

subgroup 

Joints Baseline Walker Baseline Walker Walker 

Ankle 0.385 ± 0.065 0.387 ± 0.058 0.489 ± 0.140 0.357 ± 0.088 0.338 ± 0.147 

Knee 0.382 ± 0.055 0.320 ± 0.064 * 0.494 ± 0.061 0.368 ± 0.106 0.344 ± 0.138 

Hip 0.593 ± 0.125 0.557 ± 0.081 1.013 ± 0.197 0.918 ± 0.099 0.785 ± 0.182 

LOWER 

BODY 
2.72 ± 0.31 2.53 ± 0.27 3.99 ± 0.74 3.29 ± 0.52 2.93 ± 0.89 

Lumbar 0.097 ± 0.044 0.109 ± 0.054 0.310 ± 0.082 0.248 ± 0.076 0.254 ± 0.136 

Thoracic 0.070 ± 0.045 0.082 ± 0.043 0.452 ± 0.185 0.284 ± 0.138 0.346 ± 0.285 

Neck 0.015 ± 0.006 0.018 ± 0.014 0.066 ± 0.021 0.072 ± 0.044 0.076 ± 0.059 

TORSO 0.18 ± 0.09 0.21 ± 0.10 0.83 ± 0.25 0.60 ± 0.25 0.68 ± 0.47 

Scapular 0.026 ± 0.010 0.023 ± 0.014 0.083 ± 0.017 0.101 ± 0.047 0.146 ± 0.108 

Shoulder 0.017 ± 0.009 0.024 ± 0.015 0.078 ± 0.022 0.110 ± 0.030 0.141 ± 0.052 

Elbow 0.008 ± 0.003 0.012 ± 0.008 0.032 ± 0.006 0.063 ± 0.030 0.124 ± 0.108 

Wrist 0.001 ± 0.000 0.003 ± 0.002 * 0.004 ± 0.002 0.014 ± 0.007 * 0.041 ± 0.037 

UPPER 

BODY 
0.10 ± 0.04 0.12 ± 0.07 0.39 ± 0.08 0.58 ± 0.21 0.90 ± 0.61 

TOTAL 3.01 ± 0.38 2.86 ± 0.33 5.21 ± 0.83 4.47 ± 0.89 4.51 ± 1.84 
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5.3.4 Mechanical Work of the Body 

Mechanical work over the gait cycle was calculated for each joint over the gait cycle and 

the results were summed into different body segments: full body, lower body, torso, and upper 

body work. Baseline gait was compared between TD and CP groups and walker-assisted gait was 

compared to baseline gait within groups. Walker-assisted trials were compared to baseline trials 

within groups and the crutch-assisted group was compared to the unassisted group in walker-

assisted trials. 

 

5.3.3.1 TD vs CP Mechanical Work 

TD group mechanical work was compared to the CP group using SPM statistical analysis 

(Figure 5.1). Total work in TD baseline gait was characterized by small peak work contributions 

in early stance and late swing phases of gait. Additionally, large peak work occurred in late 

stance in preparation for toe off. The majority of the work was done by the lower body in TD 

baseline gait where the same patterns were observed as in the full body. Sagittal plane work 

mirrored the summation of all the planes with peaks in early and late stance and late swing. 

While frontal plane work had two peaks in early and late stance and transverse plane work had a 

peak in late stance. 

The CP group required a greater mechanical work to move through their gait successfully 

than the TD group. The CP group required a larger net work in early stance, mid-stance, and 

through swing compared to the TD group. In late stance phase, the CP group had a similar peak 

work to the TD group. Lower body sagittal plane work contributed to increased work in CP 

during early and mid-stance phase and sagittal work in the lower body was lower in late stance in 

CP. Upper body and torso segment sagittal work were also increased in CP throughout the gait 
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cycle. Frontal plane increases occurred in the torso and upper body segments while the lower 

body in CP was similar to that in the TD group.  

The CP group used their torso more for balance and stability than the TD group which 

had reduced work in the torso and upper body. Cyclic patterns in all three planes of motion in the 

torso with greater magnitudes highlight the larger activation of the torso in CP. The upper body 

also had greater use in CP with patterned usage in total work. 
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Figure 5.1: Mechanical work over the gait cycle for the full body, lower body, torso, and upper body segments. Baseline gait for TD 

group (black) and CP group (blue) work is compared using SPM analysis. SPM significance is highlighted by blue shaded boxes and 

marked with p<0.05 (*), p<0.01 (**), and p<0.001 (***). 

*** *** *** *** 
*** 

*** *** ** *** *** *** *** 

*** *** *** *** ** *** *** *** *** *** *** *** *** * 
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5.3.3.2 TD Baseline vs Walker-Assisted Gait Mechanical Work 

The TD group gait required slightly less peak mechanical work when walking with a 

walker but was not different from baseline at times of peak work (Figure 5.2). In early and late 

stance and late swing, the lower body had lower peak work in walker-assisted gait than in 

baseline. The upper body had increased work from late swing to early stance in walker-assisted 

gait. Minima of mechanical work in baseline gait occurring at mid-stance and mid-swing 

increased in walker-assisted gait in the full body, torso, and lower body. 
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Figure 5.2: Mechanical work over the gait cycle for the full body, lower body, torso, and upper body segments. TD group baseline 

gait (black) compared to manual walker gait (blue) work is compared using SPM analysis. SPM significance is highlighted by blue 

shaded boxes and marked with p<0.05 (*), p<0.01 (**), and p<0.001 (***). 
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5.3.3.3 CP Baseline vs Walker-Assisted Gait Mechanical Work 

The CP group had significantly reduced mechanical work during stance phase in walker-

assisted gait compared to their baseline (Figure 5.3). Sagittal plane work was reduced in the 

lower body particularly in early stance. The cyclic pattern from baseline gait in the frontal plane 

did not occur in the upper body and was minimized in the torso during walker-assisted gait. Peak 

upper body work changed from occurring at toe off in baseline gait to heel strike and early stance 

in walker assisted gait. 
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Figure 5.3: Mechanical work over the gait cycle for the full body, lower body, torso, and upper body segments. CP group baseline 

gait (black) and manual walker gait (blue) work is compared using SPM analysis. SPM significance is highlighted by blue shaded 

boxes and marked with p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

*** * * 
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5.3.3.4 Mechanical Work in Walker-Assisted Gait for Un- vs Crutch-Assisted Baseline Groups 

In examining the full body, the crutch-assisted (CA) group did less work than the 

unassisted (NA) group when walking with a walker (Figure 5.4). In the lower body, the sagittal 

plane work was greater in early stance and lower in late stance in the CA group. Torso segment 

peak work was reduced in early and late stance in the CA group compared to the NA group. 

Little significance occurred in the upper body comparisons but the CA group had greater peaks 

and thus greater work over the gait cycle than the NA group in the upper body segments. 
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Figure 5.4: Mechanical work over the gait cycle for the full body, lower body, torso, and upper body segments. Manual walker gait 

for NA group (black) and CA group (blue) work is compared using SPM analysis. SPM significance is highlighted by blue shaded 

boxes and marked with p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

*** ** * 

** * * *** ** *** * * 
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5.4 Discussion 

This study employed a method for calculating full body and individual joint mechanical 

work while walking with an instrumented pediatric posterior walker. Along with the 

spatiotemporal measures, kinematics, and kinetics from Chapters 3 and 4, a more complete 

picture of the pathology of CP and the effect of a posterior walker on gait was found by 

comparing the mechanical work of walker-assisted to baseline gait and quantifying the user’s 

interaction with the walker. Overall, the walker reduced the total work necessary for the 

mechanical motion of the body during gait in both the TD and CP groups. The TD and CP 

groups experienced reduced total mechanical work over the gait cycle in the lower body. In 

addition, the CP group also had reduced work in the torso and an increased work in the upper 

body. In examining the work over the gait cycle the same effects can be observed but the 

increase in work in the upper body was not clear as it was normalized to the length of the gait 

cycle. Reduced velocity observed in the walker-assisted trials may contribute to the reduced joint 

mechanical work. The posterior walker reduced the mechanical cost of gait with little side effects 

on the mechanical work of the body. Further comparisons of these outcomes to oxygen 

consumption and heart rate metrics would further inform this outcome. The results of this work 

suggest that the benefit of the walker outweighs its detriment for the CP group when considering 

the mechanical work of the body over the gait cycle. 

The mechanical work for the TD and CP group baseline trials showed similar 

relationships to previously published data. Russell et al. calculated a 59% greater work in CP gait 

compared to TD gait (S. Russell et al., 2011a). In this work, a more involved group of CP 

subjects averaged 73% greater total body work compared to the TD group during baseline gait. 

As was expected, the CP group showed significantly greater work being done in the lower body, 
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torso, and upper body segments. In the CP group, the upper body accounted for a larger portion 

of the full body work than in the TD group. This increase in work was due to the increase in 

upper body motion for angular momentum generation to aid in the balance and stability of gait. 

In TD baseline gait there was very little upper body motion observed. At toe off times the CP 

group needed greater work generation in the upper body and torso to remain stable in their 

baseline, unassisted gait compared to the TD group. While the lower body frontal plane work 

was similar in CP to TD group gait, the torso and upper body increases for stability affected the 

full body outcomes. Increases in the sagittal plane work for the lower body highlighted the 

increased cost of movement for the CP group particularly through stance phase. The 

incorporation of a walker into the CP group gait reduced the excessive motion in the upper body 

and was expected to add an energetic cost for pulling the walker around. 

The mechanical work required for gait in the TD group was mostly unaffected by the 

inclusion of the walker. The TD group did not apply a great amount of force to the walker 

compared to the CP group. It was expected that the walker inclusion in their gait would not 

change or slightly increase the total mechanical work of the body as the walker was not used for 

stability by the TD group. Compared to the baseline trials, the full body work in the walker trials 

was lower but not significant (p=0.178). In Chapter 4, the knee and hip joints had a lower range 

of motion in the TD group which reduced the mechanical work of the knee. While minor 

changes were observed throughout the gait cycle in these segments, the full body work was 

slightly reduced in early and late stance and increased in mid-stance and mid-swing.  

Pathologic CP gait showed a greater significance when comparing between baseline and 

walker-assisted trials. From Chapters 3 and 4 the CP group was more stable in walker-assisted 

gait, this was corroborated by the larger vertical and lateral forces on the walker. These forces 
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indicate a reliance on the walker for a point of contact with the ground to increase balance. The 

larger forces and work on the walker in the direction of travel also highlight the greater effort 

required to move the walker compared to the TD group. Reductions in the total lower body and 

torso work were not offset by increases in the upper body to move the walker forward. In walker-

assisted gait the lower body joints produced lower moments to achieve the motion in the model 

which reduced the work in the lower body. Peak work around toe off in the upper body and torso 

were also reduced in walker-assisted gait as the walker enabled a more stable gait and posture 

characterized by less motion and joint moment generation in the upper body. The full body work 

calculation did not show the effect of the walker energy cost between baseline and walker trials. 

The full body total work was lower for the walker trials compared to baseline which was 

counter to the outcome expected. Previous studies have found lower velocity of walking gait 

typically accompanies decreased joint moment and power (de David, Carpes, & Stefanyshyn, 

2015; Schwartz et al., 2008). The reduced velocity in walker-assisted trials could be a 

contributing factor to the reduced work calculated in the lower body and torso as this was not a 

controlled factor in this study. Larger reductions in work were observed in the CP group than the 

TD group while velocity decreased for both groups to similar levels of significance. Further 

work should examine the effect of velocity of gait on mechanical work of the joints and how it 

relates between walker-assisted and unassisted gait. The computation of body angular 

momentum would also be a valuable assessment of stability of the system for future work to 

consider (S. D. Russell et al., 2007). 

The walker-assisted trials of the subgroup of children with CP which walked with 

crutches (CS) in their baseline gait were compared to the CP group which did not use crutches 

(NA) to observe the effect of CP on the walker use for different groups of children with CP. The 
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children who used crutches in their typical gait were unable to ambulate without them and so 

were more reliant on an assistive device to move. With a smaller group who used crutches, 

significance of the results was low but the CS group trended towards a greater total mechanical 

work in walker-assisted trials than the NA group. Lower body segment work was reduced in the 

CS group but torso and upper body work were greater. Particularly, the elbow and wrist work 

were significantly increased in the CS group indicating a greater reliance on the walker for 

support. As this population was unable to walk without assistance in their baseline gait, their 

reliance on the walker was expected to be greater than the NA group. 

 

5.5 Conclusion 

Total mechanical work for the whole body, torso, and lower and upper body segments 

was calculated for TD and CP group baseline and walker trials. Mechanical work was lower in 

the TD group than the CP group. The TD group saw little difference in any summed segment 

work totals when using the walker compared to baseline. The CP group used the walker for 

support as opposed to the TD group and had to apply greater force in the anterior direction over a 

gait cycle to pull the walker. While they required more work to move the walker, the CP group 

walked better with a posterior walker and with reduced mechanical work of the body through 

their gait cycle. The mechanical work may have been effected by the velocity of gait and further 

analysis of the effect of velocity on mechanical work should be performed for this population. 

Future work to compare these outcomes to metabolic cost measures like oxygen consumption 

and heart rate would be valuable to compare to the outcomes in this work. Additionally, the 

stability of the system could be measured through angular momentum for further understanding 

of the effects of a posterior walker in CP gait.  
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Appendix A: Walker Model 

The posterior walker model (Figure A.1) was designed using AutoCAD software to be 

able to ensure the elements were made to scale and the parts had accurate weights and material 

properties. The walker was a modified Nurmi Neo Posterior Pediatric Walker made by Otto-

Bock (Figure A.2). Individual parts were created and then connected with necessary joints to 

allow for flexibility in how the walker was adjusted for each subject. Revolute joints were made 

for all four wheels and the front wheel casters. These joints allowed the walker to move as it did 

in the trial. Defined contact between the floor and the wheels created friction which drove the 

wheels to rotate. 

The walker was modified for each subject’s use and the model incorporated these 

changes. The walker was adjusted for each subject so that the handles were aligned with their 

ulnar styloid process of the wrist. Translational joints were created in the model for the height 

adjustors on the posterior frame and for the connection between the top bar and the posterior 

frame. The translational joints were free to move for the initial simulation to the first frame of the 

trial so that the height and position of the walker were accurate for the trial. After the walker 

reached the initial position and was checked to be correct the translational joints were fixed. For 

taller subjects the handles of the walker were flipped vertically to align correctly with the wrist. 

Revolute joints were created for the handles of the walker. For all subjects, the handles were 

either down or up, and the joints were updated in the model to reflect their position in the trial 

and locked in that position. This ensured the correct application of the force from the load cells 

to the subject hand center of mass.  
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Figure A.1: Walker model in MSC Adams with kinematic markers used to drive the motion of 

the walker in simulations. 

 

 
Figure A.2: Modified Nurmi Neo Posterior Pediatric Walker used for all manual walker trials 

with attached load cells for collection of handle reaction force data.   
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The computational models for each trial were constructed and simulations performed 

using the following protocol in MSC.ADAMS with the LifeMod plugin. 

 

Import Body and Attach Recording Joints (once for each subject) 

1. Put the Static C3D and SLF file for the body in the static trial folder 

2. Open MSC.ADAMS, in the upper right dialog box:  

a. First dropdown → ‘_Xchange’ 

b. Sceond dropdown → ‘Import SLF Model’ 

c. Right click in gray box → ‘Browse’ → Select static SLF file of the body 

d. Uncheck box for ‘Ground Reaction Force’ 

e. Click Apply (bottom right of window) and allow to process 

3. In upper right dialog box: 

a. First dropdown → ‘Joints’ 

b. Second dropdown → ‘Create Base Joint Set’ 

c. Click light bulb next to ‘Prepare Model with Recording Joints’ 

d. Click ‘Select All’ 

e. Click Apply, wait for teal-colored balls to appear at joints of model 

4. Save the Body model 

a. File (top left of GUI) → Save database as → 00_Body 

 

Make Static Model (once for each subject) 

 

1. Import initial static kinematic position of subject in the Static trial 

a. First dropdown → ‘Motion’ 

b. Second dropdown → ‘Import Motion Capture Data’ 

c. Right click gray box → Browse → Select the static body SLF 

d. Data prefix → type ‘static’ 

e. Apply 

2. Create spring-damper connections between motion capture and model elements 

a. Second dropdown → ‘Create Base Motion Agent Set’ 

b. Set marker set (dropdown in top middle) → ‘Plug in Gait Marker Set’ 

c. Data prefix → type ‘static’ 

d. At top of GUI, SDR → Baseball → Skeleton → Set MA weights 

e. Apply 

3. Move model to static position 

a. First dropdown → ‘_Analyze’ 

b. Second dropdown → ‘Dynamics’ (should already be here) 

c. Check box for ‘Freeze Motion Agents for Equilibrium Analysis’ 

d. At top of GUI, SDR → Baseball → Ankle Constraints → Lock Ankles 

e. Click ‘Analyze’ button, left of stop sign in dialog box 

4. Save the file 

a. Check model for errors in positioning 
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b. Click ‘Update Model Posture with Equilibrium Results’ 

c. Click ‘Synchronize Body Marker Location with Data Locations’ 

d. At top of GUI, SDR → Baseball → Ankle Constraints → Unlock Ankles 

e. File → Save database as → Name it ‘00_Static’ 

5. Create left- and right-facing static files to match direction of gait for trials 

a. Define hinge joint at center of mass of model to rotate it 

i. In file explorer, find .cmd file for ‘rotate_xxxx’ and edit in notepad 

ii. Ctrl-F to change the subject identifier to the correct subject ID for current 

model 

iii. Save as, ‘rotate_xxxx.cmd’ 

iv. In MSC.ADAMS, File → Import → Choose ‘rotate_xxxx.cmd’ 

b. Drive motion of hinge joint to rotate body 

i. Right click hinge joint in GUI 

ii. Menu: ‘Joint: rotateStatic’ → Modify 

iii. Click ‘Impose Motion(s)’ 

iv. Change Rot Z” dropdown to ‘disp(time)=’ 

v. In function box, type ‘pi/3 * time’ 

vi. In top right dialog box, First dropdown → ‘_Analyze’ 

vii. Second dropdown → ‘Dynamics’ (should already be here) 

viii. Check box for ‘Disable Motion Agents’ 

ix. Click ‘Analyze’ 

x. Click ‘Update Model Posture with Equilibrium Results’ 

xi. Delete hinge joint, right click joint 

xii. Menu: ‘Joint: rotateStatic’ → Delete, delete all dependents 

c. File → Save database as → 00_Static_R2L 

d. Repeat steps (a)-(c) from ‘00_Static’ 

i. Change ‘pi/3’ to ‘–pi/3’ 

ii. Save resulting database as 00_Static_L2R 

6. Copy the corresponding static file into all trial folders based on direction of walk for each 

trial.  

 

*** = Walker Model only, not performed for baseline trials 

General organization for folders follows: Home → Models → (Subject) → (Trial) 

                                                                             → Code → Modeling 

Models are made in Subject → Trial folders, corresponding code used for model creation is 

found in the Code → Modeling folder. 

 

Make Inverse Model for Trial 

 

1. Each trial folder should contain trial data, static model files, and MSC.ADAMS shortcut 

with ‘aviewAS’ and ‘aviewBS’ cmd files 

2. In MSC.ADAMS, File → Open Database (Don’t save changes to SDR_Utility) → select 

‘00_Static_L2R’ or ‘00_Static_R2L’, whichever applies for this trial 

3. *** Load Static Walker and floor for model 

a. File → Import 

b. File type dropdown → Adams/View Command File (*.cmd) 
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c. Right click ‘File to Read’ → Browse → select ‘01_Create Ottobock Walker – No 

Motor.cmd’ in Code → Modeling folder 

d. Click ‘Ok’ 

4. *** Update position for handles of walker 

a. Check if handles are up or down in trial, if up then do step (b) otherwise skip to 

(5) 

b. Drive motion of hinge joints on handles 

i. Right click left and right handle joints 

ii. Click modify 

iii. Click ‘Impose Motion’ 

iv. Drive displacement of joint to be ‘pi * time’ 

v. In top right dialog box, check box to ‘Disable Motion Agents’ 

vi. Run analysis for one second 

vii. Click ‘Update Model Posture with Equilibrium Results’ 

5. *** Fix Top Bar of Walker as adjustment for this portion is done 

a. File → Import 

b. File Type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse select ‘02_Fix Top Bar.cmd’ in Code → 

Modeling folder 

d. Click ‘Ok’ 

e. Click ‘Delete All’ if an error is thrown (this will happen twice or not at all 

depending on if the handle orientation was changed in step 4) 

6. *** Import Static Data for Walker 

a. File → Import 

b. File Type → Test Data 

c. Select ‘Create Splines’ 

d. Right click ‘File to Read’ → Browse → select TXT file of static walker data 

e. Independent column index → ‘1’ 

f. Click ‘Ok’ 

7. *** Make walker kinematic markers 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select 

‘03_makeWalkerPoints_newVicon.cmd’ in Code → Modeling folder 

d. Click ‘Ok’ 

8. *** Make spring connections from kinematic markers to walker model 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select ‘04_PointForceSpring.cmd’ in 

Code → Modeling folder 

d. Click ‘Ok’ 

9. Import Motion Capture Data for Body 

a. First dropdown → ‘Motion’ 

b. Second dropdown → ‘Import Motion Capture Data’ 

c. Right click gray box → Browse → Select the body marker SLF 

d. Data prefix → type ‘body’ 



Appendix  131 

 
 

e. Apply 

f. Wait for Status to display: ‘Data Set Read Complete’ 

10. Create spring damper connection from kinematic markers to body model 

a. Second dropdown → ‘Create Base Motion Agent Set’ 

b. At top of GUI, SDR → Baseball → Skeleton → Number Markers 

c. SDR → Baseball → Skeleton → Set MA weights 

d. Check notes for trial to see if any spring-damper weights should be set to 0 

because they were missing during the trial 

e. Set marker set (dropdown in top middle) → ‘Plug in Gait Marker Set’ 

f. Data prefix → type ‘body’ 

g. Apply 

i. Should yield red dots and two sets of yellow dots in GUI 

h. SDR → Baseball → Skeleton → Sync New MA 

11. Perform Simulation to bring body, and walker if applicable, to initial frame of trial 

a. First dropdown → ‘_Analyze’ 

b. SDR → Baseball → Skeleton → Clear Old MA 

i. Should see one set each of red and yellow dots now 

c. Check box for ‘Freeze Motion Agents for Equilibrium Analysis’ 

d. Click ‘Analyze’ 

e. Check for correct kinematic location of body and walker 

f. Click ‘Update Model Posture with Equilibrium Results’ 

12. *** Delete walker spring connections 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select ‘04_PostStatic_Test.cmd’ in Code 

→ Modeling folder 

d. Click ‘Ok’ 

13. File → Save database as → ‘01_trial_FirstFrame.bin’ 

a. Trial = trial name 

b. Ex: ‘01_UVAWalker01_FirstFrame.bin’ 

14. Perform inverse kinematic simulation for body 

a. First dropdown → ‘_Analyze’ 

b. SDR → Baseball → Skeleton → Clear Old MA 

c. Uncheck box for ‘Freeze Motion Agents for Equilibrium Analysis’ 

d. Click ‘Set End Time to Motion Data End’ 

e. Click ‘Analyze’ 

f. Watch simulation to see if it worked 

i. Click icon, , in the main tool box (left) 

ii. Click play forward to watch trial 

iii. This analysis is just for body so do not worry about the walker if it is 

present 

iv. Check to make sure the body kinematics look correct 

g. Click ‘Save Analysis’ in upper right dialog box 

i. Name → inv 

ii. Click ‘Ok’ 

h. File → Save database as → ‘01_trial_Inv.bin’ 
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Make Dynamic Body Models 

 

1. Continue from database from step 14 

2. Load floor if not done already (Walker trials can skip this step) 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select ‘newLabFloor.cmd in Code → 

Modeling folder 

d. Click ‘Ok’ 

3. Load ground reaction force plate data 

a. File → Import 

b. File type → Test Data 

c. Select ‘Create Splines’ 

d. Right click gray box → Browse → select TXT file of force plate data 

e. Independent column index → ‘1’ 

f. Select ‘Ok’ 

4. Apply ground reaction forces 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select trial-specific cmd file for FP 

application 

d. Click ‘Ok’ 

i. In GUI, red arrows for moments and forces should appear on ankles of 

subject 

5. Create PD controllers for joints based on joint kinematics from inverse simulation 

a. First dropdown → ‘Joints’ 

b. Second dropdown → ‘Training’ 

c. Click the lightbulb in the ‘Forward Dynamics’ row 

d. Click ‘Apply’ 

i. Joints should turn dark blue/purple 

6. Create COM Tracker Force to make COM follow inverse kinematic motion 

a. First dropdown → ‘Motion’ 

b. Second dropdown → ‘Create Tracker Agent’ 

c. Check box for ‘Create Track Force Data Request’ 

d. Add two zeroes to both stiffness and both damping values 

e. All ‘_dof’ should be set to driven 

f. Click ‘Apply’ 

i. Finished when Status reads ‘Synchronize MA Locations’ 

7. Perform dynamic simulation for body 

a. First dropdown → ‘_Analyze’ 

b. Check box for gravity → click ‘-Y’ button 

c. Click ‘Set End Time to Motion Data End’ 

d. Check box for ‘Disable Motion Agents’ 

e. Click ‘Analyze’ 

f. Watch simulation to see if it worked 
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i. Click icon, , in the main tool box (left) 

ii. Click play forward to watch trial 

iii. This analysis is just for body so do not worry about the walker if it is 

present 

iv. Check to make sure the body kinematics and kinetics look correct 

g. Save Analysis 

i. Name → fwd 

ii. Click ‘Ok’ 

8. File → Save database as → 02_trial_Fwd.bin 

9. Export Data 

a. Press F3 to open command window (sometimes it takes two presses) 

b. In command line, type: var cre var=.world.trial str=‘trial’ 

i. Trial is the current trial, eg UVAWalker01 

c. Got to PostProcessor View. Click the icon, , in main tool box (left) 

d. File → Import → Command File 

e. Right click ‘File to Read’ → Browse → select 

‘PlotAngleTorqueForces_fixedDirections_fwd.cmd’ in Code → Adams Post-

Processing folder 

10. File → Save database 

a. Don’t create a backup copy 

 

Make Dynamic Walker Models 

 

1. ***Import walker motion capture data 

a. File → Import 

b. File type → Test Data 

c. Select ‘Create Splines’ 

d. Right click ‘File to Read’ → Browse → select TXT file of moving walker data 

e. Independent Column Index → ‘1’ 

f. Click ‘Ok’ 

2. ***Create walker kinematic markers in model 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select ‘WalkerMotionWalking.cmd’ 

d. Click ‘Ok’ 

3. ***Make forces to drive motion of walker 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select ‘MakeBushingMovements.cmd’ 

d. Click ‘Ok’ 

4. ***Load walker handle reaction force data 

a. File → Import 

b. File type → Test Data 

c. Select ‘Create Splines’ 

d. Right click ‘File to Read’ → Browse → select TXT file of load cell data 

e. Independent Column Index → ‘1’ 
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f. Click ‘Ok’ 

5. ***Apply walker handle reaction force data to model 

a. File → Import 

b. File type → Adams/View Command File (*.cmd) 

c. Right click ‘File to Read’ → Browse → select trial-specific load cell cmd file 

d. Click ‘Ok’ 

i. To view the handle reaction forces it will help to increase the transparency 

of the hands to ~70 

ii. To do this, right click the ‘Part: Right Hand’ and select ‘Appearance’, then 

modify ‘Transparency’ 

6. ***Run dynamic walker model simulation 

a. First dropdown → ‘_Analyze’ 

b. Check box for gravity → click ‘-Y’ button 

c. Click ‘Set End Time to Motion Data End’ 

d. Check box for ‘Disable Motion Agents’ 

e. Click ‘Analyze’ 

f. Watch simulation to see if it worked 

i. Click icon, , in the main tool box (left) 

ii. Click play forward to watch trial 

iii. Check to make sure the body and walker kinematics and kinetics look 

correct 

g. Save Analysis 

i. Name → fwdWalker 

ii. Click ‘Ok’ 

7. ***File → Save database as → 02_trial_FwdWalker.bin 

8. ***Export Data 

a. Got to PostProcessor View. Click the icon, , in main tool box (left) 

b. File → Import → Command File 

c. Right click ‘File to Read’ → Browse → select 

‘PlotAngleTorqueForces_fixedDirections_fwdWalker.cmd’ in Code → Adams 

Post-Processing folder 

9. ***File → Save database 

a. Don’t create a backup copy 

 

Repeat for all trials until done 
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Appendix B: Future Considerations 

Automated-Walker Assisted Gait in Children with and without Cerebral 

Palsy: Kinematics, Kinetics, and Work 

B.1 Introduction 

Cerebral Palsy (CP) is a non-progressive motor development disorder initiated by a lesion 

to the brain around the time of birth. CP inhibits the growth and function of ambulatory muscles 

in the lower legs which causes different visual gait patterns depending on how it manifests itself 

in the patient. Bipedal walking at a self-selected speed is typically characterized by getting from 

one position to the next in an efficient manner. For persons with CP, gait efficiency is 

significantly lower than their typically developed peers due to excess motion used for balance 

and cocontraction of muscles (Ries & Schwartz, 2018; S. Russell et al., 2011a). This excess 

energy cost is important for clinicians to keep in mind as they consider interventions to assist 

with gait. While CP is non-progressive, children with CP are observed as they grow because 

their muscles do not grow linearly with their bones. This can cause further motor impairment and 

make ambulation more inefficient. Clinical intervention often includes the prescription of the use 

of an assistive device which acts to stabilize the user during walking, like a posterior walker. 

Many studies have shown that the gait of children with CP requires more energy use 

compared to their typically developed peers through oxygen consumption and heart rate 

measures (Norman et al., 2004; Unnithan et al., 1996). Studies have also shown that as children 

with CP age their energy use increases (Bolster et al., 2017b). These estimates of energy cost on 

the individual cannot correlate an increase in cost to a specific time in the gait cycle as they are 

calculated for whole periods of activity. Mechanical energy metrics can be applied to the whole 

body while still providing individual time points of data for different segments of the body. In 
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pediatric CP gait mechanical work is higher than in the gait of their typically developed peers 

(Van de Walle et al., 2012; van den Hecke et al., 2007). For mechanical energy outcomes to be 

accurate they must incorporate the entire body for analysis otherwise the minimum energetic cost 

would be biased by the excluded segments.  

A motorized walker has the potential to decrease the work required by the user for their 

gait, while still providing the positive outcomes of stability and support for the CP population. It 

is important to decrease the cost of the walker on the body but not to entirely remove the 

energetic cost of gait. Children with CP need to continue walking and training their muscles to 

avoid muscular atrophy, which would result in them using a wheelchair later in life. The control 

for motorizing a walker used in this work used an infrared sensor to calculate the distance of the 

user from the back of the walker. As the subject moved from their initialized position, torque was 

applied to the wheels to keep the subject’s distance from the walker the same or less than the 

initialized position. In preparing the control, TD subjects walked with the walker and the control 

was tuned to where the subject could walk without pulling the walker along and steering it when 

necessary. 

Additionally, the interaction of assistive devices and a child with CP has not been given a 

lot of attention in literature. Previous work examining walker use made mechanical energy 

calculations for upper body segments of the body and have not looked at the whole body. One 

study by Konop et al. (Konop et al., 2009) looked at upper body kinetics during walker use. They 

found preliminary data suggesting a relationship between heart rate and the force used to move 

the walker forward. Other studies have only looked at the kinematics of the gait and did not 

instrument the device to model kinetics (Krautwurst et al., 2016b; Paul et al., 2007; Protas et al., 

2007). This work calculated whole-body mechanical joint work over the gait cycle. Calculations 
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were made for the exclusion and inclusion of the walker interaction to be able to define the 

importance of including the assistive device reaction forces in the kinetic model. It was 

hypothesized that the total body mechanical work would show similar trends as previously 

published metabolic data and that the incorporation of the walker would increase the accuracy of 

the model outcomes. 

 

B.2 Methods 

B.2.1 Automated Control of a Walker 

A pediatric posterior walker was instrumented with an infrared (IR) sensor that detected 

the distance of the torso away from the back of the walker. The control mechanism for 

accelerating the walker used the output from the IR sensor to apply torque to the wheels to move 

the walker as the user moved forward. Through experimentation with the weights of the PID 

control in TD subjects the walker followed along with a subjects’ gait without noticeable need 

for pulling and only required steering in the event of a turn. 

 

B.2.2 Subjects and Model 

The anthropometric data for the same 17 children collected in the Motion Analysis and 

Motor Performance laboratory at the University of Virginia from Chapter 3 was used. Data 

exported from Vicon Nexus software was filtered and prepared in Matlab then modelled in 

MSC.Adams with the LifeMod plugin. A model with 19 segments and 18 joints was created for 

each subject based on individual anthropometric data. Trials for walking with a manual and 

motorized posterior pediatric walker and were modelled. Inverse dynamic simulations were 
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performed and joint kinematics and kinetics were exported as model outputs. Individual outputs 

from walker trials were exported for analysis. 

Kinetic analysis was performed on four subjects in the CP group. The motorized walker 

had different handles in earlier trials and the forces at the handles of the walker were not 

collected for those subjects. 

 

B.2.3 Spatiotemporal Analysis 

Spatiotemporal analysis was conducted for trial outputs as presented in previous work 

from kinematic data (Johnson et al., 1997; Ju Kim & min Son, 2014; Pauk et al., 2016). Stride 

length for the left and right leg stride were calculated as the distance travelled by the respective 

foot between the first and second heel strike of the same foot. The two locations of the foot were 

calculated as the average of the ankle, heel, and toe markers at the heel strike time points. Stride 

length was normalized by the length of the respective leg so that the results could be compared 

across different subjects. Step length for the left and right step was calculated as the distance 

from the contralateral to the ipsilateral foot at heel strikes of the respective feet. The location of 

the feet was the average of the three foot markers on the foot. Step length was normalized by the 

length of the respective leg for which the step was taken. 

Stride time was calculated as the period from initial heel strike to terminal heel strike and 

reported in seconds (Figure B.1). The cadence was calculated as the inverse of the stride time 

and converted to steps per minute. Velocity was calculated by dividing the non-normalized stride 

length by the stride time.  
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Figure B.1: Gait cycle events and terminology. 
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Contralateral foot off and contact and ipsilateral toe off events were calculated as 

percentage of gait cycle from initial to terminal heel strike. Two values for each parameter were 

generated for each trial as left and right strides were used for this analysis. Single and double 

support time for both left and right strides were calculated using events labelled from force plate 

data. Single support time was calculated from adding the time period between contralateral toe 

off and contralateral foot strike and the time period between ipsilateral toe off and ipsilateral foot 

strike. Double support time was calculated by adding the time period between initial foot strike 

and contralateral toe off and the time period between contralateral heel strike and ipsilateral toe 

off. Single and double support were calculated as percentage of the gait cycle by dividing the 

time of support by the respective stride time for the left and right stride. 

Parameters were compared using statistical t-tests where the samples were assumed to 

have equal variance for comparing within groups and unequal variances for comparisons 

between groups. 

 

B.2.4 Reaction Forces 

The ground and walker handle reaction forces were recorded for walker-assisted gait 

trials with the manual and control-automated walkers. Posterior walkers reduce the load on the 

lower body joints in populations which rely on the walker for ambulation (Bateni & Maki, 2005; 

Fast et al., 1995). The GRF was examined so that the reliance on the walker could be quantified 

at different times over the gait cycle. A greater reliance on the walker would present as a lower 

magnitude GRF over the gait cycle. Handle reaction forces were examined to define the 

dependence on the walker and the applied force to move the assistive device by each group. The 
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CP group was expected to have a higher reliance on the walker and use more force to move the 

walker along through their gait cycle. 

 

B.2.5 Total Mechanical Work 

Gait efficiency is an important outcome measure in assessing the motor function of 

children with cerebral palsy (Bolster et al., 2017b; Norman et al., 2004). Mechanical work 

estimates the energy cost on an individual by quantifying the mechanical energy cost of 

movement. Using the model outputs, the mechanical work was calculated like that presented by 

Chen et al. (Chen et al., 1997). The mechanical work at the joint j is calculated as the sum over 

the gait cycle of the product of the joint torque (𝑇𝑗) and joint angle (𝐴𝑗): 

𝑊𝑗
𝑇 = ∫ |𝑇𝑗 ∗ 𝐴𝑗|

𝑔𝑐

𝑑𝑡 

Mechanical work calculates the minimum work required for the system’s movement. 

Cocontraction and metabolic costs are not included, each joint’s contribution to the total cost is 

included. Individual joint totals were summed up over the gait cycle to calculate full body, lower 

body, and upper body mechanical work. 

 

B.2.6 Joint Work 

Calculating mechanical work of joints gives the ability to break the body down into 

individual segments and identify the joints with the greatest moments produced and the specific 

timepoints during the gait cycle where the work was greatest or least: 

𝑊𝑗 = |𝑇𝑗 ∗ 𝐴𝑗| 
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The body was split up into three parts: lower body joints including ankles, knees, and 

hips; upper body joints including wrists, elbows, shoulders, and scapulas; torso joints including 

lumbar, thoracic, and neck. The work generated at these segments was examined in relation to 

the gait cycle. The absolute value of the joint work was calculated so that when summing up into 

different segments there would be no cancellation between positive and negative values of work 

for different joints. 

 

B.3 Results 

B.3.1 Subjects 

The same subject group used in earlier chapters was used for this study. Subject 

anthropometrics were recorded during collection. Two groups were created to compare outcomes 

within the groups of how they used the manual and automated walkers. One group was 

comprised of children with a diagnosis of cerebral palsy (CP) and another of typically developed 

(TD) peers as a control group. The automated walker was only instrumented for two of the TD 

group and four of the CP group. Kinetics were examined in these subjects while spatiotemporal 

and kinematic measures were examined in all subjects. 

 

B.3.2 Spatiotemporal Gait Parameters 

Spatiotemporal metrics of gait were compared between manual walker and automated 

walker gait within the TD and CP groups (Table B.1). In the TD group, automated walker gait 

was not significantly different than manual walker gait in spatiotemporal metrics. The TD group 

trended towards having shorter strides and lower velocity in automated walker gait, but no other 

differences were observed. The CP group was slightly more affected when walking with the 
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automated walker compared to the manual walker. Shorter time in single support was observed 

but no other significance was found. Although not significant, changes in spatiotemporal metrics 

indicate the CP group walked better with the automated walker. Stride length remained constant 

from manual to automated walker gait while velocity and cadence increased. Percentage of time 

spent in double support increased as well.  
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Table B.1: Spatiotemporal Parameters. Significance within groups between manual and 

automated walker trials is marked as * (p<0.05), ** (p<0.01), *** (p<0.001). 

Parameter Type TD CP 

   Parameter Manual Automated Manual Automated 

Spatial     

   Stride Length (m) 1.17±0.17 1.13±0.14 0.88±0.09 0.88±0.09 

   Normalized Stride Length 1.39±0.12 1.35±0.12 1.15±0.14 1.15±0.12 

   Step Length (m) 0.58±0.08 0.55±0.07 0.42±0.04 0.43±0.04 

   Normalized Step Length 0.69±0.06 0.66±0.05 0.56±0.06 0.56±0.06 

   Velocity (m/s) 1.07±0.14 1.02±0.11 0.68±0.16 0.74±0.20 

Temporal (gc = gait cycle)     

   Single Support (% of gc) 77.3±3.28 77.6±3.85 72.7±6.24 71.3±1.04 

   Double Support (% of gc) 22.7±3.28 22.4±3.85 27.3±6.24 28.7±1.04 

   Stride Time (sec) 1.10±0.08 1.11±0.10 1.36±0.32 1.25±0.20 

   Cadence (step/min) 110.3±8.4 109.1±10.1 92.6±20.5 99.0±18.0 

   Single Support (sec) 0.85±0.05 0.86±0.06 0.98±0.21 0.89±0.15* 

   Double Support (sec) 0.25±0.05 0.25±0.06 0.38±0.14 0.36±0.05 

   Opposite Foot Off (% of gc) 11.2±1.78 11.0±1.97 13.8±3.26 14.2±0.79 

   Opposite Foot Contact (% of gc) 50.0±0.26 50.2±0.56 50.2±0.80 49.7±0.78 

   Toe Off (% of gc) 61.6±1.46 61.6±2.21 63.7±3.37 64.2±0.82 
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Splitting the CP group into subgroups yielded more significance between walker trials 

and revealed the effect of the automated walker on different users of the walker (Table B.2). The 

GMFCS II group walked faster and with more stability with the automated walker than the 

manual walker. The GMFCS II subgroup walked with a greater velocity and higher cadence with 

an automated walker and a greater percentage of time was spent in single support. The GMFCS 

III subgroup was less affected by the walker and walked with less stability in the automated 

walker. Percentage of time spent in double support was increased in the automated walker trials. 

Velocity and cadence of walk trended towards decreasing in automated walker gait for the 

GMFCS III subgroup. The crutches subgroup was a further division of the GMFCS III subgroup 

and was similarly affected by the automated walker compared to manual walker. Percentage of 

time in double support increased indicating a lack of stability in gait. The crutches subgroup 

walked better as velocity and cadence increased in automated walker trials.  
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Table B.2: Spatiotemporal Parameters for subgroups of CP group based on GMFCS level. Significance between manual and 

automated walker trials is marked as * (p<0.05), ** (p<0.01), *** (p<0.001). 

Parameter Type GMFCS II (n=2) GMFCS III (n=5) Crutches (n=3) 

   Parameter Manual Automated Manual Automated Manual Automated 

Spatial       

   Stride Length (m) 0.89-0.99 0.92-1.03 0.86±0.10 0.85±0.06 0.90±0.08 0.86±0.09 

   Normalized Stride Length 1.17-1.23 1.09-1.43 1.14±0.17 1.11±0.03 1.16±0.20 1.11±0.09 

   Step Length (m) 0.42-0.48 0.44-0.50 0.41±0.04 0.41±0.03 0.43±0.04 0.42±0.06 

   Normalized Step Length 0.57-0.58 0.53-0.69 0.55±0.08 0.54±0.02 0.55±0.10 0.54±0.07 

   Velocity (m/s) 0.62-0.84 0.94-1.09 0.66±0.18 0.63±0.06 0.63±0.24 0.66±0.10 

Temporal (gc = gait cycle)       

   Single Support (% of gc) 61.0-71.6 70.8-71.4 75.2±3.99 71.4±1.25*** 75.3±5.62 70.5±2.58** 

   Double Support (% of gc) 28.4-39.0 28.6-29.2 24.8±3.99 28.6±1.25*** 24.7±5.62 29.5±2.58** 

   Stride Time (sec) 1.18-1.46 0.96-0.99 1.38±0.38 1.36±0.08 1.54±0.41 1.32±0.13* 

   Cadence (step/min) 83.5-102.0 121.9-126.9 92.6±24.3 88.8±5.5 83.1±25.3 92.0±9.2 

   Single Support (sec) 0.84-0.89 0.68-0.70 1.03±0.24 0.97±0.08 1.14±0.24 0.93±0.08** 

   Double Support (sec) 0.34-0.57 0.28-0.29 0.35±0.14 0.39±0.01 0.40±0.18 0.39±0.06 

   Opposite Foot Off (% of gc) 14.5-19.8 14.3-14.9 12.4±2.11 14.0±0.86* 12.4±2.89 14.5±3.70 

   Opposite Foot Contact (% of gc) 51.0-51.1 49.8-50.7 49.8±0.62 49.5±0.77 49.9±0.71 49.6±5.60 

   Toe Off (% of gc) 65.1-70.2 64.1-65.0 62.2±1.74 64.1±0.92** 62.2±2.44 64.5±2.53* 
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B.3.3 Reaction Forces 

Ground reaction and walker handle reaction forces for the TD group in manual and 

automated walker trials were compared using SPM analysis (Figure B.2). Vertical ground 

reaction forces were greater in manual walker trials at the second peak approaching toe off. 

Vertical and longitudinal handle reaction forces were lower throughout the gait cycle for the TD 

group in automated walker trials. 

CP group reaction forces were compared using SPM analysis between manual and 

automated walker trials (Figure B.3). The CP group walked with more ability and activation in 

their lower body in automated walker trials. Longitudinal ground reaction forces were greater 

over mid-stance in walker trials. The CP group interacted with the walker less in automated 

walker trials compared to manual trials. Vertical handle reaction forces were decreased 

throughout the gait cycle and longitudinal forces were lower in mid-stance and mid-swing in 

automated walker trials.  
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Figure B.2: TD group 3-dimensional ground and walker-handle reaction forces over the gait 

cycle. Significance between GRF manual (black) and automated (blue) walker-assisted trials 

highlighted by blue shaded boxes and HRF manual (black) and automated (blue) walker-assisted 

trials highlighted by red shaded boxes. SPM significance marked as p<0.05 (*), p<0.01 (**), and 

p<0.001 (***) with GRF on top and HRF on bottom. Toe-off time marked by vertical lines for 

baseline (black) and walker-assisted (blue) trials.  

*** 

*** *** 

*** * ** *** 
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Figure B.3: CP group 3-dimensional ground and walker-handle reaction forces over the gait 

cycle. Significance between GRF manual (black) and automated (blue) walker-assisted trials 

highlighted by blue shaded boxes and HRF manual (black) and automated (blue) walker-assisted 

trials highlighted by red shaded boxes. SPM significance marked as p<0.05 (*), p<0.01 (**), and 

p<0.001 (***) with GRF on top and HRF on bottom. Toe-off time marked by vertical lines for 

baseline (black) and walker-assisted (blue) trials.  

*** 

* * 

*** 
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B.3.4 Model Outputs 

Dynamic models were created for three trials of each condition of walking for each 

subject. The model outputs included joint angles and moments for the defined joints of the 

model. TD and CP group manual and automated walker gait were compared to examine the 

effect of the automated control of the walker on the user’s gait. The whole TD and CP groups 

were used in kinematic comparisons but only two TD and four CP subjects were used for joint 

kinetic comparisons. The automated walker was only instrumented for these two TD and four CP 

subjects to provide accurate kinetics to compare to manual walker trials. Within group 

differences were marked with shaded boxes on the figures where the automated walker trials 

were significantly different from manual walker-assisted gait. Pelvic segment tilt, obliquity, and 

rotation angles were included to show the inherent neutral angle of the model, as it was not 

equivalent to anatomical neutral. Pelvic tilt angles were offset from neutral by values between -

10 and -18 degrees, while obliquity and rotation angles fluctuated around 0 degrees. 

 

B.3.4.1 TD Group Manual vs Automated Walker-Assisted Gait 

TD group joint kinematics for the whole group in automated walker trials were 

moderately different in the lower body (Figure B.4). The TD group postured themselves 

differently when walking with the automated walker. Greater flexion in the hip and knee at toe 

off reveal a decreased range of motion of these joints. Thoracic joint flexion was greater 

indicating a worse posture when walking with an automated walker (Figure B.5). The shoulder 

and elbow joints kinematics were characterized by greater abduction and greater pronation 

respectively throughout the gait cycle (Figure B.6). Joint kinetics were not significantly different 

between manual and automated walker trials for the TD group. Shoulder and elbow flexion 
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moments were lower in automated trials which is likely a factor of the walker control decreasing 

the need for pulling forces on the walker.  
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Figure B.4: Lower body joint kinematics (left) and kinetics (right) for the TD group manual (black) compared to automated (blue) 

walker-assisted gait. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***). 

  

* 

** * 
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Figure B.5: Trunk kinematics (left) and kinetics (right) and pelvic segment kinematics (bottom) for TD group manual (black) 

compared to automated (blue) walker-assisted gait. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), 

p<0.01 (**), and p<0.001 (***). Trunk flexion was characterized by bending forwards and extension by bending backwards based off 

of pelvic tilt. Positive lateral bending and axial rotation was in the direction of rotation towards the stance foot. Pelvic tilt is negative 

for forward rotation, obliquity is positive for rotation away from stance foot rotation is positive for vertical-axis rotation away from 

stance foot.   

* * * 
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Figure B.6: Upper body kinematics (left) and kinetics (right) for TD group manual (black) compared to automated (blue) walker-

assisted gait. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

*** 

*** 
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B.3.4.2 CP Group Manual vs Automated Walker-Assisted Gait 

The CP group joint kinematics were better in the lower body when walking with an 

automated walker (Figure B.7). Hip and knee joint flexion in midstance was lower and had 

greater range of motion through the gait cycle. Lower body kinetics were greater in automated 

walker trials. Hip extension moment was greater in early stance and late swing and knee flexion 

moment was greater in mid-stance. Torso joint kinematics and kinetics were not significantly 

different between manual and automated walker trials, but automated walker trials trended 

towards worse posture and higher load on the torso (Figure B.8). Thoracic joint lateral bending 

angle varied more in automated walker trials. Joint moment was greater in the thoracic and 

lumbar joints in the lateral direction highlighting the increased need for support of the torso 

through the gait cycle in automated walker-assisted gait. Upper body joint kinematics were not 

affected by walking with an automated walker (Figure B.9). Elbow extension moment was 

reduced in stance phase while shoulder extension moment was increased in late stance and swing 

in automated walker trials.  
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Figure B.7: Lower body joint kinematics (left) and kinetics (right) for the CP group manual (black) compared to automated (blue) 

walker-assisted gait. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

* *** 
** 

** 

* *** 



Appendix  157 

 
 

 
Figure B.8: Trunk kinematics (left) and kinetics (right) and pelvis segment kinematics (bottom) for CP group manual (black) 

compared to automated (blue) walker-assisted gait. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), 

p<0.01 (**), and p<0.001 (***). Trunk flexion was characterized by bending forwards and extension by bending backwards based off 

of pelvic tilt. Positive lateral bending and axial rotation was in the direction of rotation towards the stance foot. Pelvic tilt is negative 

for forward rotation, obliquity is positive for rotation away from stance foot rotation is positive for vertical-axis rotation away from 

stance foot.   

* 

* 
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Figure B.9: Upper body kinematics (left) and kinetics (right) for CP group manual (black) compared to automated (blue) walker-

assisted gait. SPM significance highlighted by blue shaded boxes and marked as p<0.05 (*), p<0.01 (**), and p<0.001 (***).
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B.3.5 Total Mechanical Work 

Mechanical joint work was compared between manual and automated walker-assisted 

trials for the TD group and two subgroups of the CP group that were unassisted and crutch-

assisted in their baseline gait (Table B.6). These groups had lower members in them as the 

automated walker was only instrumented for some of the subjects. The total mechanical joint 

work for the TD group was mostly unaffected when walking with the automated walker 

compared to the manual walker. The full body total mechanical joint work for the TD group was 

not different in automated walker trials compared to manual trials. Thoracic joint work was 

reduced which also caused the summed segment for the torso to be decreased in automated trials. 

The CP unassisted subgroup had increased total joint work in automated walker trials 

compared to manual walker trials. Increased lower body joint work occurred through the hip 

along with minor increases in the knee and ankle. Larger torso work was the result of increased 

joint work in the thoracic and lumbar joint work in the automated walker trials. 

With only one subject, the CP crutch-assisted subgroup had large standard deviations and 

low significance. The subject tended towards a greater full body joint work form increases in the 

lower body and upper body, while the torso remained relatively consistent to the manual walker 

trials. 
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Table B.6: Average total mechanical work for individual joints summed over a gait cycle. Significance between baseline and walker 

trials for TD group and Unassisted CP group is marked as * (p<0.05), ** (p<0.01), *** (p<0.001). Walker assisted trials of crutch and 

unassisted subgroup are compared and marked following the same method. 

Work 

(J/kg*m) 

TD Group CP Group 

(n=2) Unassisted subgroup (n=3) Crutch-assisted subgroup (n=1) 

Joints Manual Automated Manual Automated Manual Automated 

Ankle 0.391-0.516 0.388-0.513 0.377 ± 0.120 0.401 ± 0.150 0.506 ± 0.157 0.847 ± 0.710 

Knee 0.375-0.447 0.356-0.406 0.418 ± 0.138 0.539 ± 0.050 0.442 ± 0.066 0.391 ± 0.088 

Hip 0.536-0.601 0.562-0.566 0.948 ± 0.215 1.208 ± 0.058** 0.940 ± 0.115 1.120 ± 0.267 

LOWER 

BODY 
2.60-3.13 2.62-2.96 3.49 ± 0.76 4.29 ± 0.46** 3.77 ± 0.51 4.72 ± 2.04 

Lumbar 0.059-0.071 0.056-0.077 0.256 ± 0.091 0.334 ± 0.114* 0.390 ± 0.062 0.479 ± 0.149 

Thoracic 0.039-0.049 0.040-0.043 0.309 ± 0.164 0.441 ± 0.199* 0.675 ± 0.126 0.675 ± 0.105 

Neck 0.010-0.011 0.008-0.015 0.077 ± 0.052 0.095 ± 0.074 0.144 ± 0.018 0.126 ± 0.020 

TORSO 0.11-0.13 0.11-0.13 0.64 ± 0.30 0.87 ± 0.37* 1.21 ± 0.19 1.28 ± 0.25 

Scapular 0.016-0.022 0.012-0.014 0.107 ± 0.064 0.107 ± 0.044 0.268 ± 0.203 0.258 ± 0.085 

Shoulder 0.010-0.012 0.010-0.014 0.103 ± 0.048 0.112 ± 0.047 0.194 ± 0.100 0.274 ± 0.109 

Elbow 0.005-0.009 0.016-0.021 0.061 ± 0.053 0.069 ± 0.034 0.247 ± 0.179 0.312 ± 0.290 

Wrist 0.000-0.002 0.000-0.002 0.015 ± 0.008 0.011 ± 0.005 0.083 ± 0.061 0.096 ± 0.064 

UPPER 

BODY 
0.06-0.09 0.08-0.10 0.57 ± 0.31 0.60 ± 0.26 1.59 ± 1.06 1.88 ± 0.83 

TOTAL 2.78-3.34 2.82-3.19 4.70 ± 1.21 5.76 ± 0.73* 6.57 ± 1.21 7.87 ± 2.21 
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B.3.6 Mechanical Work of the Body 

Mechanical work over the gait cycle was calculated for each joint over the gait cycle and 

the results were summed into different body segments: full body, lower body, torso, and upper 

body work. TD and CP groups were compared between manual and automated walker-assisted 

gait. The CP group was comprised of four subjects and the TD group had two subjects as the 

automated walker was instrumented for these subjects. 

 

B.3.6.1 TD Manual vs Automated Walker-Assisted Gait Mechanical Work 

The TD group mechanical work in walker-assisted gait was mostly equivalent in 

automated and manual trials (Figure B.10). Reduced mechanical work occurred at two points 

during the gait cycle segments of the body. Lower body and full body sagittal plane mechanical 

work was lower in early stance phase which indicates a reduced initial loading on the lower body 

in stance. Reduced sagittal plane mechanical work in the torso at toe off highlights a lower 

necessary activation of the torso to enable the swing phase.  
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Figure B.10: Mechanical work over the gait cycle for the full body, lower body, torso, and upper body segments. TD group manual 

(black) compared to automated (blue) walker-assisted gait work is compared using SPM analysis. SPM significance is highlighted by 

blue shaded boxes and marked with p<0.05 (*), p<0.01 (**), and p<0.001 (***). 

** 

*** 

*** 
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B.3.6.2 CP Manual vs Automated Walker-Assisted Gait Mechanical Work 

Mechanical work was increased in the CP group automated walker trials in all segments 

of the body (Figure B.11). The lower body was taxed to move the body during stance phase more 

in automated walker trials than it was in manual walker trials. Total lower body and full body 

work was increased in early to mid-stance primarily from increased sagittal plane work. Torso 

and upper body joints were used to stabilize during transition periods of gait at toe off and heel 

strike and the mechanical work increased at these points in automated walker trials. Sagittal and 

frontal plane mechanical work of the torso was increased in automated walker trials during late 

stance phase. Upper body mechanical work increased during times of heel strike and toe off. The 

CP group walked worse with the automated walker as the mechanical work to move increased 

over their gait cycle.  
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Figure B.11: Mechanical work over the gait cycle for the full body, lower body, torso, and upper body segments. CP group manual 

(black) and automated (blue) walker-assisted gait work is compared using SPM analysis. SPM significance is highlighted by blue 

shaded boxes and marked with p<0.05 (*), p<0.01 (**), and p<0.001 (***).  

** ** ** * 

* * * 
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B.4 Discussion 

This study developed a method for calculating full body mechanical work while walking 

with an instrumented pediatric posterior walker. Subjects walked with a manual and automated 

walker to examine the effect of the control on the walker on gait parameters and model 

outcomes. The TD group walked with slightly less mechanical work over their gait cycle while 

the CP group walked with more mechanical work, particularly in the lower body and torso 

segments when using the automated walker. While the CP group walked faster with the 

automated walker, the increased work required over the gait cycle indicates the control on the 

walker was not helpful in their gait. Further development of the control and alternate methods 

could prove more beneficial in an automated walker as it did allow the CP group to pull on the 

walker less during their gait. 

For the both TD and CP groups, spatiotemporal parameters were unaffected by the 

automated walker compared to the manual walker, but by breaking the CP group up by GMFCS 

the effect of the automated control was found. The GMFCS II group walked faster and with 

more stability when they did not need to interact with the walker as much to pull it along. They 

returned to walking as they did in their baseline without the posterior walker or other support. 

The GMFCS III group walked worse with the automated walker, also regressing to similar 

spatiotemporal gait parameters as were observed in Chapter 3 in their baseline gait. Based on 

joint kinematic and kinetic analysis the CP group had mixed positive and negative effects on 

their gait when walking with the automated walker. The lower body joints had a greater range of 

motion and reduced load on the knee, but there was increased moment at the hip. The torso 

moved more laterally and greater moment generation indicated the subjects were not as stable in 
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their gait. These effects on gait by the automated walker are opposite that which was observed by 

the manual walker compared to baseline gait. 

Handle reaction forces were lower in the vertical direction for both groups in the 

automated walker trials indicating the walker was not used as much for support. This could be 

due to the population not adjusting to the automated walker and not trusting the motion of the 

walker as much as the manual one. Future work giving subjects extended time to get accustomed 

to the automated walker could answer if a control on the walker destabilizes the user in their gait 

or if they need time to get used to walking with it.  

For both groups, the effects of a walker from baseline gait to using a manual walker were 

reversed by incorporating the control designed for the walker. The TD group benefited by from 

the automated walker by returning to a lower total mechanical work over their gait. In manual 

walker trials we saw an increase in this segment from baseline, the TD group returned to a gait 

that resembled their baseline gait and less work was performed by the torso. Walker-assisted gait 

required more energy with a control-automated walker than a manual walker in the CP group. 

The CP group walked with greater mechanical work generation in the lower body and torso 

segments, which is also where the largest changes were seen from baseline to manual walker 

trials.  

 

B.5 Conclusion 

TD and CP groups walked with a manual walker and an automated walker with a custom 

control designed to keep the walker at an initialized distance away from the subject for 

supportive needs. The automated walker caused users to walk similar to their baseline gait. For 

the TD group this was better, as energy was not expended to pull the walker along. The CP group 
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was hindered by the automated walker as the control increased their minimum energy required 

for gait and decreased their stability while walking. A control for an automated walker designed 

around the particular use and interaction of the CP group with the walker could yield a more 

stable and efficient gait in the CP population as the group walked faster and with better posture 

than their baseline gait with the control designed in this work.  
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